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ED I TO RI AL

This magazine was created using :

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE.

I

t's another full house this month. We have Python, LibreOffice, VAX-VMS, Inkscape, Arduino,
and an extra HowTo on using LaTeX. In reviews, I'm having a look at GoPanda (a Go client for
IGS) and Art is reviewing Linux Lite.
Charles (Linux Labs) has written an interesting article on testing and troubleshooting old hard
drives. If you want to geek out on hard drive fetch times and such-like then this is definitely the
article for you. Meanwhile, I try out the Android 'app' Debian noroot. It lets you install a slimmed
down Debian on your Android device. And, as the name suggests, it does not require rooting your
device.
Speaking of devices; next issue, I'll have a review of the BQ Aquaris M10 Ubuntu Edition
tablet. I'll be trying it as a tablet, and with a wireless/Bluetooth keyboard and mouse to see how it
performs as a laptop/desktop machine.
And, if you haven't yet given it a listen, try the Full Circle Weekly News. As I write, I've just
released FCWN#1 3. Of course, by the time you read this I'll probably be releasing FCWN#1 6 or
thereabouts. It's purposely kept short (under 1 0 minutes) and usually features around seven or
eight news items. No fluff, nor chit-chat, just the best Ubuntu/Linux/FOSS news items of the
week.

UPDATE: As this issue comes to completion I'm sad to announce the passing

of Brian Donovan who produced most of our ePUB and special editions. This
issue is dedicated to him, and his family. My deepest condolences.

All the best, and keep in touch!
Ronnie
ronnie@fullcirclemagazine.org
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Find Full Circle on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
http://issuu.com/fullcircle
magazine
http://www.magzter.com/
publishers/Full-Circle

Weekly News:

http://fullcirclemagazine.org
/feed/podcast
http://www.stitcher.com/s?
fid=85347&refid=stpr
http://tunein.com/radio/FullCircle-Weekly-Newsp855064/
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Submitted by Arnfried Walbrecht

THE FULL CIRCLE
WEEKLY N EWS

"ACCEL64 FOR LINUX"
SOFTWARE SUPPORTS 64-BIT
DATA ACQUISITION
PROCESSORS

M
A short podcast (<1 0min)
with just the news. No chitchat. No time wasting. Just
the latest FOSS/Linux/
Ubuntu news.

RSS:

http://fullcirclemagazine.
org/feed/podcast

icrostar Laboratories, a
provider of Data Acquisition
Processor (DAP) systems for PCbased high-performance
multichannel measurement
applications, has released version
1 .00 of the Accel64 for Linux
software. This package builds
Loadable Kernel Module (LKM)
software for the GNU/Linux
system, for running on 32-bit or 64bit hardware architectures, to
support the control of DAP data
acquisition boards on systems
using kernel versions in the 4.xx
series. Accel64 for Linux is offered
under the BSD license as a free
download.
The Accel64 for Linux software
determines what kind of hardware
platform is present and selects the
native interface mode as the
default. However, advanced users
who have implemented kernel
support for 32-bit software
full circle magazine #1 08

architectures under a 64-bit
hardware platform can use either
the 64-bit or 32-bit interface,
depending on application
requirements.
Source: http://www.electronicseetimes.com/news/accel64-linuxsoftware-supports-64-bit-dataacquisition-processors

KDE PLASMA 5.6 RELEASED

K

DE Plasma is the desktop
environment that powers
Kubuntu, Chakra Linux and
openSUSE (among others). This
week sees the release of Plasma
5.6, which brings several tweaks
and improvements.

environments. KDE provides plenty
of opportunities to tweak and
streamline the experience.
Of course, the range of choice
available in the desktop world
means that users are well cared
for, whatever their preferences.
KDE isn't the only configurable
desktop environment, and some
users prefer minimal window
managers or text-only interfaces.
Previous versions of Plasma
have offered an attractive
interface, and the latest release is
no exception. This incarnation
offers some new polish in the
standard themes. Some of these
are minor tweaks, such as
improving the tooltip animations.
Small as they are, they do improve
the overall feel.

KDE is a modern desktop
Source:
environment, but unlike several
http://www.linuxjournal.com/conte
desktop environments, it has
nt/kde-plasma-56-released
avoided the trend of "dumbing
down" the interface. Although
there's much to be said for a
simplified environment, power
users value the ability to customize
and configure their work
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TINY WIRELESS -RICH COM
RUNS LINUX ON
SNAPDRAGON 820

e

Infochips has opened preorders on a tiny, wireless-rich
“Eragon 820” COM and
development kit that run Linux or
Android on a Snapdragon 820 SoC.
The eInfochips Eragon 820 is
the second computer-on-module
we’ve seen based on Qualcomm’s
high-end quad-core 64-bit
Snapdragon 820 system-on-chip
after Intrinsyc’s 82 x 42mm,
SODIMM-style Open-Q 820 COM,
which similarly comes with a
development kit. The Linux- and
Android 5.1 .1 ready 53 x 25mm
module and 1 1 0 x 85mm carrier
are aimed at “next generation
designs in Ultra HD/4K camera and
connectivity solutions,” says the
company.
Source:
http://linuxgizmos.com/tinywireless-rich-com-runs-linux-onsnapdragon-820/

CANONICAL ANNOUNCES
THE AVAILABILITY OF
U BUNTU 1 6.04 LTS B ETA
FOR IBM LINUXONE

M

any businesses and
enterprises around the
world are praising IBM's System z
and LinuxONE product line for
their unrivaled reliability and
security, and Ubuntu Linux is being
recognized as one of the most
popular free operating systems,
the perfect OS for running scaleout workloads in the cloud.
In approximately three weeks
from today, on April 21 , 201 6,
Canonical will unveil the final
release of their highly anticipated
Ubuntu 1 6.04 LTS operating
system, dubbed Xenial Xerus by
the company. And it looks like
Ubuntu 1 6.04 LTS will be the
perfect choice for IBM’s LinuxONE
and Systems z product lines for
cloud deployments.
Source:
http://news.softpedia.com/news/c
anonical-announces-theavailability-of-ubuntu-1 6-04-ltsbeta-for-ibm-linuxone502298.shtml
full circle magazine #1 08

U BUNTU M AKE N OW LETS
YOU I NSTALL SUPERPOWERS,
ECLIPSE JEE, I NTELLI J EAP
& KOTLIN

F

Source:
http://news.softpedia.com/news/u
buntu-make-now-lets-you-installsuperpowers-eclipse-jee-intellijeap-kotlin-502363.shtml

or those not in the know,
Ubuntu Make is an open-source H EAD OF O RACLE LINUX
command-line tool designed from MOVES TO M ICROSOFT
the ground up to help developers
hile at the Linux
and programmers install all sorts
Collaboration Summit, I
of third-party applications that
discovered that Wim Coekaerts,
aren't available in the Ubuntu
formerly Oracle's Senior VP of
repos or don't have a PPA.
Linux and Virtualization
According to Mr. Roche, Ubuntu Engineering, has left Oracle for
Make 1 6.03 is here to add support Microsoft.
for installing the Superpowers
Coekaerts is a very well-known
2D/3D game maker software, as
well as the Eclipse IDE for Java EE Linux leader. In Oracle he was
developers, IntelliJ IDEA EAP (Early known as "Mr. Linux." In his Oracle
tenure, he brought the company its
Access Program), and the Kotlin
first Linux products, moved
compiler.
Oracle's programming staff from
Windows to Linux desktops and
Besides all the goodies
turned Oracle into a Linux
mentioned above, Ubuntu Make
distributor with the launch of its
1 6.03 adds some extra tests for
Red Hat Enterprise Linux (RHEL)
the Microsoft Visual Studio Code
clone, Oracle Linux.
IDE (Integrated Development
Environment), improves the
Microsoft confirmed that it had
Portuguese translation, and fixes
enticed Coekaerts to leave Oracle
bugs for Android-NDK, Unity3D,
for Microsoft. Mike Neil,
Visual Studio Code, Clang, and
Microsoft's Corporate Vice
Intellij-based IDEs.
President of the Enterprise Cloud,
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told me, "Wim Coekaerts has
joined Microsoft as Corp VP of
Open Source in our Enterprise
Cloud Group. As we continue to
deepen our commitment to open
source, Wim will focus on
deepening our engagement,
contributions and innovation to
the open-source community."
Source:
http://www.zdnet.com/article/hea
d-of-oracle-linux-moves-tomicrosoft/

LINUX CONTAINER SECURITY
IS ON THE EVOLUTIONARY
FAST TRACK

I

t's been a well-known fact for
many years that the standard
hypervisor approach to virtualizing
a server has a basic flaw in its
architectural premise -- it requires
each virtual machine to run a
separate operating system
instance. Hypervisors are designed
to enable any operating system to
run in a VM, allowing for a greater
degree of flexibility. This also
means that Windows instances can
exist alongside Linux instances in
the same machine.

Once we reach scale levels
found in cloud providers, it
becomes apparent that there is no
real need to mix OSes on any given
server, as there are so many
instances, segregating them
doesn't impact flexibility. With this
realization comes the
understanding that the hypervisor
method wastes a great deal of
memory and I/O cycles, since as
many as hundreds of copies of the
OS could exist on any given server.

KDE Plasma 5.6.1 desktop
environment, Calamares 2.2
graphical installer, Octopi 0.8.1
graphical package manager, Qt 5.6
GUI toolkit, Budgie Desktop 1 0.2.5
desktop environment, numerous
Linux kernels updates, a BlueZ bug
fix, and improvements to the
Menda GTK3 theme.

Linux conference, the Linux
Foundation's 201 6 Embedded
Linux Conference & OpenIoT
Summit.

It's not that embedded Linux
hasn't been important before. Your
DVRs and Wi-Fi routers almost
certainly run Linux. What has
changed is that the Internet of
As usual, the software
Things (IoT) is transforming
repositories of Manjaro Linux
embedded Linux from being a
1 5.1 2 (Capella) have been
topic only programmers could love
synchronized with upstream, which to one everyone will be using soon.
Source:
means that it includes all the latest
http://searchservervirtualization.te software updates and security
This development caught
chtarget.com/tip/Linux-container- patches from the Arch Linux
Torvalds, Linux's founder, by
security-is-on-the-evolutionaryoperating system as of March 30,
surprise -- 1 5 years ago. "I never
fast-track
20:28:59 CEST, 201 6.
see the entire chain running Linux.
Twenty five years ago I started
Source:
Linux wanting a workstation. From
http://news.softpedia.com/news/la that to a server wasn't a surprise.
LATEST M ANJARO LINUX
test-manjaro-linux-1 5-1 2-updateThere was no single point where I
1 5.1 2 U PDATE B RINGS
brings-linux-kernel-4-5-and-kdewas surprised, but 1 5 years ago I
plasma-5-6-1 -502502.shtml
started seeing these odd,
LINUX KERNEL 4.5 AND
embedded systems. The first one
KDE PLASMA 5.6.1
that really caught my eye was a gas
pump running Linux."
he Manjaro Linux development LINUX FOUNDER TORVALDS
team announced the general
ON THE I NTERNET OF
Source:
availability of the fourteenth
http://www.zdnet.com/article/linu
update pack for the Manjaro Linux THINGS : S ECURITY PLAYS
xs-founder-linus-torvalds-on-the1 5.1 2 (Capella) operating system.
SECOND FIDDLE
internet-of-things/
With this update, Manjaro Linux
or the first time, Linus Torvalds
1 5.1 2 users will receive the latest
has spoken at an embedded

T
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LINUX FOUNDATION
ANNOUNCES CIVIL
I NFRASTRUCTURE PLATFORM

O

n the first day of the
Embedded Linux Conference,
the Linux Foundation announced a
new software project called the
Civil Infrastructure Platform (CIP).
CIP is an open source
framework that will support the
development of software needed
to run critical services that create
the backbone of any modern
society, including electric power,
oil and gas, water, health care,
communications, and
transportation.
With CIP, the foundation is not
only addressing issues related to
duplication of work and
interoperability that come from
using proprietary software, but is
also putting open source at the
center of this massive market.
According to a 201 4 PWC report,
the global capital project and
infrastructure market was worth
$4 trillion in 201 2 and is expected
to climb to nearly $9 trillion by
2025, with 'the majority of the
growth' coming from emerging
economies.

FULL LINUX-ON -PS4 HITS
G ITHUB

the text generated by the A.I. to be
extremely accurate, they trained it
intensively on images of just 1 00
different types of object, so at
present it is limited to identifying
human, pizza, baseball and the like,
Source:
but as research progresses, the
http://www.theregister.co.uk/201 6 captions will get increasingly
/04/04/full_linuxonps4_hits_github versatile and complex.

ver since fail0verflow first told
Chaos Computer Club that
Sony PS4 machines could be
persuaded to run Linux, a fair
amount of work has gone into
replicating his demonstration.

H OW ARTIFICIAL
I NTELLIGENCE WILL
TRANSLATE FACEBOOK
PHOTOS FOR THE B LIND

Source:
http://www.cio.com/article/3051 1
81 /open-source-tools/linuxfoundation-announces-civilinfrastructure-platform.html

E

not a demonstration video, it's a
“fully operational dlclose exploit”
(referring to the Webkit exploit
widely believed to lie behind
fail0ver's original disclosure).

W

hile it's easy to dwell on the
The problem for other PS4
potential threats of artificial
hackers: to avoid take-downs and
intelligence, much more often the
other things from Sony,
field promises to make humans'
fail0verflow published only a Linux- lives better. A.I. algorithms are
to-PS4 port, leaving the rest of the meant to help us connect with our
world to discover the specific
friends, find information, and even
exploit used.
transport us through the physical
world.
That unleashed a widespread
effort, not only to find the best
Starting today, Facebook is
exploit, but to turn it into
using artificial intelligence to
something stable.
automatically generate text
captions for every photo on
According to a piece at
Facebook, to provide much-needed
Wololo.net, Githubber kR1 05 has
accessibility for the blind or
laid hands on the holy grail.
visually impaired.

Source:
http://www.popsci.com/howartificial-intelligence-will-translatefacebook-photos-for-blind

O PEN -SOURCE AMDGPU
LINUX D RIVER G ETS M AJOR
U PDATE WITH M ORE THAN
50 I MPROVEMENTS

A

MDGPU (also known as xf86video-amdgpu) is an opensource and very performant
graphics driver dedicated to AMD
Radeon GPUs (Graphics Processing
Units), integrated into the mainline
Because the developers wanted Linux kernel since version 4.2. Until

However, this, Wololo writes, is
full circle magazine #1 08

The feature is available now on
Facebook's iOS app, and will be
rolling out to other platforms
soon, as well as to languages other
than English.
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now, AMDGPU received a single
minor update, xf86-video-amdgpu
1 .0.1 , but today's release adds
multiple changes.

attacks.

W

ith the new move, users of
the Ubuntu MATE for
The BillGates malware is a
Raspberry Pi OS platform will now
relatively old malware family
receive access to the forthcoming
aimed at Linux machines running in Ubuntu MATE 1 6.04 LTS (Xenial
Release highlights of AMDGPU server environments. Its primary
Xerus) branch. The update is
1 .1 .0 include support for the
purpose is to infect servers, link
expected to bring users a host of
upcoming Polaris 1 0 and 1 1 family them together in a botnet
new features including a new
of AMD GPUs, makes the OpenGL controlled via a central C&C server, Welcome screen built specifically
and VDPAU (Video Decode and
which instructs bots to launch
with Raspberry Pi-centric features
Presentation API for Unix)
DDoS attacks at their targets.
in mind, as well as many updated
interoperation to work with DRI3
components.
enabled, add the "TearFree" option
The malware has been around
to prevent tearing with reflection for some years, and due to its
The most exciting addition to
and rotation under X.Org Server
(irony-filled) name is probably one Ubuntu MATE 1 6.04 for Raspberry
1 .1 6 or later.
of the most well-known Linuxwould be the new onboard Wi-Fi
targeting malware families.
and Bluetooth support made
Source:
possible by the BlueZ 5.37
http://news.softpedia.com/news/o
While not as powerful as the
component.
pen-source-amdgpu-linux-driverXOR botnet, which was capable of
gets-major-update-with-morelaunching 1 50+ Gbps attacks,
This new system is based on the
than-50-improvementsBillGates attacks can go over 1 00
Linux Kernel 4.1 .1 9 LTS, and
502700.shtml
Gbps when needed.
includes Raspberry firmware
1 .201 6031 5-1 , wiringpi 2.32,
Source:
DD OS ATTACKS WITH
nuscratch 201 601 1 5, sonic-pi 2.9.0,
http://news.softpedia.com/news/d and omx-player
B ILLG ATES LINUX M ALWARE dos-attacks-with-billgates-linux- 0.3.7~git201 60206~cb91 001 .
malware-intensify-502697.shtml
I NTENSIFY
Source:
ver the past six months,
http://www.mobipicker.com/board
security researchers from
O N -B OARD WI -FI ,
-wi-fi-bluetooth-support-ubuntuAkamai's SIRT team have observed
mate-1 6-04-raspberry-pi-3/
B LUETOOTH SUPPORT I N
a shift in the cyber-criminal
underground to using botnets
U BUNTU MATE 1 6.04 FOR RESEARCHERS HELP SHUT
created via the BillGates malware
RASPBERRY PI 3
to launch massive 1 00+ Gbps DDoS
full circle magazine #1 08
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DOWN SPAM BOTNET THAT
ENSLAVED 4,000 LINUX
MACHINES

A

botnet that enslaved about
4,000 Linux computers and
caused them to blast the Internet
with spam for more than a year has
finally been shut down.
Known as Mumblehard, the
botnet was the product of highly
skilled developers. It used a
custom "packer" to conceal the
Perl-based source code that made
it run, a backdoor that gave
attackers persistent access, and a
mail daemon that was able to send
large volumes of spam. Command
servers that coordinated the
compromised machines'
operations could also send
messages to Spamhaus requesting
the delisting of any Mumblehardbased IP addresses that sneaked
into the real-time composite
blocking list, or CBL, maintained by
the anti-spam service.
Source:
http://arstechnica.com/security/20
1 6/04/researchers-help-shut-downspam-botnet-that-enslaved-4000linux-machines/
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TORVALDS PREPARED TO
SPEND NEXT 25 YEARS
HELPING LINUX CONQUER
THE DESKTOP

T

he phrase "year of the Linux
desktop" has been around for
well over a decade, but it has
become more of a meme rather
than a statement of fact. Without
a doubt, Linux has seen much
success on mobile devices,
including smartphones and tablets,
as well as servers, network
appliances, and the emerging
"internet of things" device
category. However, despite
Microsoft stumbling with Windows
Vista and Windows 8.x, Linux failed
to capitalize on these moments of
weakness. In a recent interview
with CIO, Torvalds cited that the
"desktop hasn't really taken over
the world like Linux has in many
other areas". However, he
remained positive about the
prospects of Linux on the desktop.

failed ambition to crowdsource an
Ubuntu-powered smartphone
offering a full desktop PC
experience may have been ahead
of its time but serves as an
indication of things to come.
Source:
http://www.neowin.net/news/torv
alds-prepared-to-spend-next-25years-helping-linux-conquer-thedesktop

I NTERPRETING , ENFORCING
AND CHANGING THE GNU
GPL, AS APPLIED TO
COMBINING LINUX AND ZFS

T

In January of 2005, we added to
our license list an explanation that
the Common Development and
Distribution License, version 1 .0
(CDDL), though a free license, is
incompatible with all versions of
the GNU General Public License
(GNU GPL). While the CDDL is not
commonly used, it is the license
that Sun Microsystems (and now
Oracle) chose for distributing the
file system ZFS. ZFS was originally
written for Solaris, but recent
projects aim to make it work as a
module with other operating
system kernels, including Linux,
which is licensed under the terms
of the GNU GPL version 2.

Normally, incompatibility
questions like this are raised by
people trying to write proprietary
modules for copyleft free
programs. They want to benefit
from the work done by free
software developers without
providing others the same
This statement explains why the freedom, and they treat users
unethically. That is not the case
current license of ZFS prevents it
here, because ZFS is free software.
If we look through an alternate from being combined with Linux.
The ideal solution would be for
To reach that conclusion, our
lens, Linux may end up seeing
Oracle, who has become a large
more success as we head towards a statement covers all the necessary and tremendously influential
background for understanding
future where hybrid and
distributor of GPL-covered code, to
license incompatibilities and
converged solutions are
show their leadership by giving
violations in general.
increasingly offered. Canonical's
explicit permission allowing their
full circle magazine #1 08
9
he Free Software Foundation
published a statement called
"Interpreting, enforcing and
changing the GNU GPL, as applied
to combining Linux and ZFS," by
our founder and president, Richard
M. Stallman.

ZFS work to be used under the
GPL.
Source:
https://www.fsf.org/licensing/zfsand-linux

CANONICAL EASES U BUNTU
APP D EVELOPMENT WITH
N EW B UILD D EPENDENCY
RULES

U

buntu release manager Steve
Langasek informs the
community about some changes
happening to build-dependency
handling in Ubuntu 1 6.04 LTS
(Xenial Xerus) and upcoming
versions of the widely used
operating system.
According to Mr. Langasek, the
Ubuntu development team admits
that the process of separating
Ubuntu packages between the
"main" and "universe" software
repositories caused the Ubuntu
development to be dragged down
because the "main" repo also
covered build-dependencies in
addition to dependencies.
Starting with the upcoming
contents ^
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Ubuntu 1 6.04 LTS (Xenial Xerus)
operating system, the Ubuntu
development team will offer a
more lightweight "main"
repository containing only the
packages that matter most to end
users. Work on this has already
started by moving many Ubuntu
packages from "main" to
"universe."
Source:
http://news.softpedia.com/news/c
anonical-eases-ubuntu-appdevelopment-with-new-builddependency-rules-502783.shtml

CANONICAL I S D ELIGHTED
TO COLLABORATE WITH
N EXENTA ON O PTIMIZING
ZFS FOR U BUNTU

C

anonical announced the
extension of their partnership
with Nexenta to provide their
customers with a joint softwaredefined storage solution.
The joint solution formed by
Nexenta, the world's most popular
OpenSDS (Open Source-driven
Software-Defined Storage)
developer, in collaboration with
Canonical, the company behind

one of the world's most popular
Linux kernel-based operating
systems, is here to pair the Ubuntu
OpenStack platform with the
award-winning SDS solution from
Nexenta.

C

anonical's Dustin Kirkland
informed the Ubuntu
community about the availability
of the Docker 1 .1 0 Linux container
engine for every supported
architecture in Ubuntu 1 6.04 LTS
(Xenial Xerus).

Networking, allowing users to
connect all of their Docker
containers that are spread across
the network.

Source:
http://news.softpedia.com/news/u
During the OpenStack Summit
buntu-1 6-04-lts-brings-docker-1 201 5 event, both Canonical and
Ubuntu 1 6.04 LTS launches next 1 0-with-fan-networking-to-everyNexenta have announced an
architecture-503061 .shtml
week, on April 21 , 201 6, and
upcoming alliance that will benefit Canonical has started revealing
enterprise OpenStack customers
many of its upcoming features.
from a new software-defined
Some of those, which may interest U BUNTU -B ASED E SCUELAS
storage solution, by integrating
LXD users, are support for the
LINUX 4.4 RELEASED FOR
NexentaEdge, the high
Docker 1 .1 0 Linux container engine
performance object and block
on every Ubuntu architecture and S CHOOLS AS A WINDOWS
storage service from Nexenta, with the ability to run Docker inside
XP REPLACEMENT
Canonical's Juju open source
LXD.
service modeling tool, which
he biggest piece of news
Ubuntu users can use to manage,
Therefore, after upgrading their
concerning the Escuelas Linux
deploy, and scale apps on
systems to Ubuntu 1 6.04 LTS on
4.4 release is that the OS has been
OpenStack clouds.
April 21 and after that, users will
rebased on the recently
find Ubuntu Docker binaries and
announced Bodhi Linux 3.2
Source:
images for the ARMHf, ARM64
distribution, which in turn is based
http://news.softpedia.com/news/c (AArch64), i686 (32-bit), amd64
on the Ubuntu 1 4.04 LTS (Trusty
anonical-is-delighted-to(64-bit), PPC64el (PowerPC 64-bit Tahr) operating system.
collaborate-with-nexenta-onLittle Endian), and s390x (IBM
optimizing-zfs-for-ubuntuSystem z) hardware architectures.
However, it looks like there are
502806.shtml
so many internal changes that the
Dustin Kirkland, who is part of
Escuelas Linux development has
U BUNTU 1 6.04 LTS B RINGS Canonical's Ubuntu Product and team declared the 4.4 release as
Strategy team led by Mark
the most important in the history
D OCKER 1 .1 0 WITH FAN
Shuttleworth, has also had the
of the project, and it is highly
N ETWORKING TO EVERY
great pleasure of announcing the
recommended as a replacement
general availability of Ubuntu Fan for old Windows XP PCs.
ARCHITECTURE

T
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buntu-sdk-ide-and-devkit-officially- (GPIO) ports for your own tinkering
mention the ability to detect
ARM64 (AArch64) devices, support released-for-ubuntu-1 6-04-builtand experimenting. The ARMfor migrating templates to UITK (UI on-qt-5-6-5031 88.shtml
based computer can run a number
Toolkit) 1 .3, as well as the upgrade
of operating systems including
of the Ubuntu Desktop Kit to the
Debian, Ubuntu, and Android.
APIs of the OTA-1 1 update for
THE ODROID XU4 IS A
Ubuntu Touch mobile OS.
Source:
PALM -SIZED PC WITH AN
https://www.yahoo.com/tech/affor
Moreover, it is now possible to OCTO -CORE PROCESSOR , BUT dable-arm-based-computersenable
the distribution of the
evolved-1 31 55701 7.html
Numerous of the pre-installed
CAN
IT
BE
YOUR
DESKTOP
?
Ubuntu SDK IDE and DevKit
packages have been updated to
packages in the "snap" and "click"
their latest versions at the
ini-PCs like the Raspberry Pi
moment of the release of Escuelas formats, and there is also the
are loved tinkerers and retro
ability
to
adjust
the
HTML5
Linux 4.4, and among the most
gamers — could they be fast
template
to
mirror
the
QML
important ones, we can mention
enough to take on the everyday
sample application. The UI Toolkit things you’d do on a desktop PC?
LibreOffice 5.1 .2, Mozilla Firefox
(UITK) component gallery has been Here’s a look at one single board
45.0, and Geogebra 5.0.226.
improved, and it should work as
computer, the ODROID XU4, and
expected
now
(available
from
Source:
how it stacks up as a desktop
http://news.softpedia.com/news/u Tools -> Ubuntu -> Showcase
computer, complete with x86
Gallery).
buntu-based-escuelas-linux-4-4emulation through Exagear
released-for-schools-as-a-windowsDesktop, so it can run programs
In
the
coming
days,
the
Ubuntu
xp-replacement-5031 36.shtml
like Skype and even Microsoft
SDK team will prepare a small
Office.
point release promising to add a
U BUNTU SDK IDE AND
new welcome screen, which
The ODROID XU4 is a single
provides users with direct access to board computer built by
D EVKIT O FFICIALLY
the UI Toolkit showcase gallery, as Hardkernel. At the heart of the
RELEASED FOR U BUNTU
well as a fully functional desktop
XU4 is a Samsung Exynos 5422
1 6.04, B UILT ON Q T 5.6
kit targeted at click packaged
2GHz, octo-core processor, with
(ARMHf) pocket desktop IDE
2GB of RAM. The board also packs
uilt on Qt 5.6.0 and based on
(Integrated Development
gigabit Ethernet, two USB 3.0
Qt Creator 3.5.1 , the new
Environment).,
ports, a single USB 2.0 port, HDMI
Ubuntu SDK IDE and Devkit
output, a CPU cooling fan, and
packages come with a great set of Source:
new features. Among them, we can http://news.softpedia.com/news/u general-purpose input/output
full circle magazine #1 08
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But you can also install Escuelas
Linux on computers where
Windows 8 or Windows 1 0 is
running much more easily, thanks
to the UEFI improvements added
in the 4.4 release. Additionally, the
installation manual has been
completely redesigned.
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CO M M AN D & CO N Q U ER J SO N D a ta ba se Wi th P yth on

Written by Lucas Westermann

few months ago, I was asked
to create a JSON database for
integration into an ubuntu phone
app. Up until then, I’ve only ever
used JSON files, but not created
them from real-world data/files. I
then set about using Python to list
all files that should appear in the
app, and creating the relevant
JSON data. Since then, I’ve begun a
data management and analysis
course - where we work with
similar JSON files. So for this
month’s C&C, I’m going to walk you
through how I created a new
Python script to create a JSON
database of my previous C&C
articles. This way, I’ll be able to
easily check when I wrote an
article, and what the topic was.

THE SCRIPT
I’ve posted my copy of the
script on Pastebin:
http://pastebin.com/eLASuY1 T

used as-is. You can easily adjust it
These changes are mandatory to generate lists/databases of files and need to be adjusted for your
based off filenames. This is what I’ll system. Optional changes can be
be focusing on in the article.
found in the next section.

WHAT WILL I N EED?
The scripts are tested in Python
3.5. Older versions of 3 should
work without issues - if you’re
using Python2, you’ll need to
adjust the code according to the
error messages you’re given.
I’ve linked my version of the
script with Drive - the CLI tool for
managing Google Drive. If you’re
not interested in using it, you can
safely ignore/delete the lines 3-6,
26-40, and 1 07. Otherwise you’ll
need: Drive (see Further Reading),
and to have imported
subprocess.call, and
contextlib.contextmanager.
Otherwise the rest of the
imports are necessary, and
standard libraries.

B UT… I D ON ’T H AVE YOUR
ARTICLES!
WHAT D O I N EED TO
CHANGE?
This script isn’t intended to be

full circle magazine #1 08

You’ll want to edit line 9 - this is
the target file (txtFile) for the
intermediary list of all articles.

The reason it’s not integrated into
the function, is so it can be more
easily changed.
Line 1 7 contains the empty
dictionary which is used per entry.
It could be integrated into a
method, but I left it in to illustrate
how it works (and to ensure that
there’s a -1 element to delete).

You’ll also need to edit line 1 3 and adjust the list to contain the
H OW D OES I T WORK?
paths you want to include in your
database. It is expected to be a list,
The first 25 lines are mainly
so even if you’re looking at a single
variables that need to be set up for
path, make sure it’s wrapped in
later functions. Most should be
square brackets.
self-explanatory, and so I will skip
them. Lines 26-40 are explained in
If you don’t separate out the
the section “Drive Functions”.
filename information with “ - “,
then you’ll need to change line 70.

WHAT CAN I CHANGE?

FUNCTION : DATEFIND

This function was created to
calculate
the month and year that
Line 1 0 indicates the file path to
corresponds to the article. This is
the JSON file. By default it’s fcmdatabase.json in the current folder. important for me, as some topics
can be outdated - so if a topic was
covered in 201 2, it may be time for
Line 1 6 contains a dictionary
a refresh. It does so by knowing
that stores the date of issue 1 00
one date (#1 00 was for August,
(August, 201 5). This is important
201 5), and the difference between
for the calculations in dateFind.
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COMMAND & CONQUER
the currently processed issue, and
issue 1 00. So issue 98 would be a
difference of 2, and 1 07 would be
-7. The difference (times 365/1 2 roughly one month) is then
subtracted from the date of the
startPoint (201 5-08), and results in
a new year and month. The days
shift, but since FCM is a monthly
release, it’s unimportant (and even
deleted entirely with the strftime
function).

One could also just multiply 32
by the difference - though having
that many extra days for some
months may cause more problems.
It’s by no means perfect - as it’s
cumulative, there may be problems
with February issues (for example).

FUNCTION :
CREATEARTICLELIST
This function uses os.listdir, and
some regexp/searches to ensure
that only my articles are accounted
for. Since my files are in the format
FCM1 00 - C&C - Title, I simply make
sure the filename starts with
FCM[0-9]+ (one or more numbers
after the FCM). I also make sure it
doesn’t contain .desktop (this is
important for drive - as every file
has a .desktop companion). Once

the lists have been added into
output, the list isn’t flat (has
multiple sublists). That’s what line
54 fixes.
Line 55 removes any .odt
extension listed (as Google Drive
files have no extension, and .odt
was what I originally used). Lastly, I
use the same sort of replace
function to shorten any Command
& Conquer into C&C - not strictly
necessary, but ensures things are
uniform.
Line 57 ensures there are no
duplicates - as a Python set can
contain only unique values. This
essentially drops any duplicate
filenames.
The list is then printed into a
temporary file (which is practical
for debugging, or if you just want
to see quickly how many files there
are). The file is then closed, and
the function returns True.

FUNCTION :
UPDATE_DATABASE

the following steps:
• Split the line on the “ - “ separator
(so you get a list like this:
[‘FCM1 00’, ‘C&C’, ‘Title’])
• Removes the FCM part - to get
just the issue number.
• Creates an empty key/value pair
in the entry dict.
• Fills the information into the
entry dict (if the title is empty - as
some of my files were poorly
named in the past, it just inserts a
string “Unknown”). It also removes
any newline characters.
• dateFind is used to calculate the
estimated date for that issue.
• Database.update is used to insert
(or update) the information for the
current issue.
Once the for loop is completed,
the file is then closed, the -1 entry
of the database (original
entryTemplate) is deleted, and the
database is returned.

FUNCTION : WRITE_DATABASE
This is a quick function that
uses json.dumps to simply write
the dict to a JSON file. It also
indents it nicely.

This is the crux of the file. It
essentially opens the article-list.txt FUNCTION :
file, and reads each line of it. For
WRITE_CSV_DATABASE
each non-empty line, it then does
full circle magazine #1 08
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This function uses csv.writer to
create a valid CSV file. Line 95
dumps the keys of an entry
(specifically, entry 1 00) into a list.
The list is then used to create the
CSV header, and also to make sure
the order of the values are the
same as the headers - so it
matches up.

FUNCTION : MAIN
This is just a function where I
call the rest of the helper
functions (and debugged issues).
You can just as easily paste this
into the if __name__ == “__main__”
area, but the recommendation is to
use a main function, to allow easier
importing.

D RIVE FUNCTIONS
FUNCTION : CD
This just recreates the cd
function from Bash, but also
reverts to the original directory so that the drive pull command can
be executed in the correct
directory, without messing up later
writes to JSON or CSV files.
Originally found on StackOverflow
(see Further Reading).
contents ^

COMMAND & CONQUER
FUNCTION : UPDATE_DRIVE
This calls the cd command
inside a with (to ensure the
directory reverts), and calls drive
pull.

file and search by hand, open it in
some form of data analysis tool, or
write a new function to search the
nested dictionary structure in
Python itself.

I hope this article proves
interesting to at least a few
WHY D O SOME FUNCTIONS readers. Or, barring that, gives you
some inspiration for new projects
RETURN TRUE?
of your own. If you have any
comments, suggestions or
This is mainly to indicate that
the function completed correctly. extensions, feel free to email me
It’s also a useful step if you want to at lswest34+fcm@gmail.com.
support error handling.

WHAT D O I D O WITH THE
D ATABASE?
There are a few things you can
do. Using something like
OpenRefine, you can clean up your
database (such as find out which
files are lacking titles). Or else you
can export it to a CSV and import it
into Google Sheets or similar.
Lastly, you can open it in
something like Python’s Pandas
and analyse it however you’d like.

CAN I SEARCH ?
You can either open the JSON

EXTRA! EXTRA!
READ ALL ABOUT IT!
Our glorious news reporter
(Arnfried) is posting regular
news updates to the main Full
Circle site.

FURTHER READING
https://github.com/odekeem/drive
Drive CLI tool.

Click the NEWS link, in the site
menu at the top of the page,
and you'll see the news
headlines.

http://stackoverflow.com/question
s/431 684/how-do-i-cd-inpython/241 76022#241 76022
Stack Overflow cd command in
Linux.

Alternatively, look on the right
side of any page on the site,
and you'll see the five latest
news posts.
Feel free to discuss the news
items. It's maybe something
that can spill back from the site
into the magazine. Enjoy!

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.

full circle magazine #1 08
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Written by Greg D. Walters

elcome back. This month
will be a hodgepodge of
information. The main reason is
that there are some important
advances in tech and you will need
time to get some parts for the
next few articles.

P yth on I n Th e Rea l World - Pt 65

• Male to Male jumpers (Arduino to
Breadboard) about 8”
• Male to Male jumpers
(Breadboard to Breadboard) small
to medium
• Toy/Hobby motor 6 VDC
• L293D or SN75441 0 Motor
Control Chip
• 4 AA Battery Holder and
Batteries.

currently the Echo / Alexa is
available only in the US and many
people in the UK and other
countries have been waiting, not
so patiently, for it. This gives them
a chance to enjoy the technology.

There are at least two projects
currently working on getting Echo
In the near future, we will be
on the Pi. The first uses Java. You
adding the Arduino into our
can find the code and instructions
toolbox. I suggest starting off with
This will pretty much get you
at https://github.com/amzn/alexathe UNO or a UNO clone which can
be purchased for less than $30 US going for the next few months. Of avs-raspberry-pi. I have done this
course, you could get more and
project on both a Pi Version 1 B and
(£22). We will also need some
explore on your own. Most
the new Pi 3B. It worked well on
sensors to really get going. While
both. Many people have problems
these are optional and you can just everything on the list is less than
$1 0 US. If you shop the internet
getting this to work, but I did it in
read the article, building these
diligently,
you
can
get
very
good
about 4 hours (with small breaks
projects are more than half the
and interruptions), and it worked
fun. So, with that said, here is a list prices on everything really
inexpensively. We’ll leave this for
the first time. The best advice I can
of parts…
now, but for next time, you will
give you is take your time, plan on
• One Wire Digital Temperature
need
the
DS1
8B20
temperature
a long weekend, and follow the
Sensor - DS1 8B20
sensor and a 4.7K resistor as well
instructions to the letter. The only
• DHT1 1 Basic
as a breadboard and jumpers if you problem that I had was that npm
Temperature/Humidity Sensor
don’t already have one.
and nvm needed to be installed,
• 1 6x2 LCD Display
and, at that time, these installation
• 4.7K and 1 0K ¼ Watt resistors (3
Recently, there has been a
instructions were not included. I
or 4 of each)
• Large Breadboard (60+ x 1 0 with great stir on the Internet about the believe this issue has been
Amazon Echo / Alexa device
corrected.
power rails)
software
being
ported
to
run
on
• 1 0K Potentiometer (2 or 3)
the Raspberry Pi. The biggest
The second project uses Python
• Male to Female jumpers (Pi to
reason for the excitement is that
and is located at
Breadboard) about 8”
full circle magazine #1 08
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https://github.com/lennysh/AlexaP
i. To be honest, I tried this, but
could not get it to run. I will tell
you that I did not spend nearly as
much time on this project as I did
on the Java version, due to many
doctor visits this past week. I
intend to spend more time on it to
try to get it working.
If you decide to try either
projects, PLEASE use a blank SD
card and not one that has
something you want to keep. Load
the Raspbian or NOOBS OS from
scratch. That way, if something
goes wrong, you can just reload
the OS and start fresh.
There are some things you need
to know before you attempt to do
this project. All of the information
below pertains to the java version,
but some can be considered to
apply to both projects…
• You need to have a USB
microphone. Headphone based
microphones have issues. I’m using
a Logitech webcam with built in
microphone and it works well.
• You will also need a set of
speakers or headphones attached
contents ^

HOWTO - PYTHON

to the audio out jack. Many people
have had lots of issues with
bluetooth audio devices.
• You must push a button to get
the Echo / Alexa to listen for your
command. It doesn’t currently
listen for the “wake” word. (more
below).
• Some of the features that the
actual Echo / Alexa have don’t
currently work.
• Things like location, weather,
traffic, work correctly only in the
USA. In any other country, you will
get information for Seattle,
Washington, USA
• The only supported language
currently is English. According to
what I was able to find out from
my research is that, once the
device is being sold in a given
country, they will add support for
that country's “official” language. I
understand that in the UK, the
official language is English, and
that in the USA, there is no
“official” language and that
Spanish is a largely spoken
language, but is not supported on
the device as yet. There are many
flame threads on the web – if you
wish to voice your ire at the fact
that your language of choice is not
supported or that the Echo / Alexa
is not available there. All I can
suggest is that you should be

patient. The device was a sleeper
for a while and just recently took
off well. Amazon, I’m sure, is
working on support for other
countries right now.
• When you start the app, you have
to run two processes. The second
one will create a GUI box which has
a long URL string that you must
copy and paste into a web browser.
Once that gets to Amazon
properly, then you must click the
[OK] button on the screen. You will
be presented with a screen that
has a [Start Listening] button and
some multimedia buttons. To
“wake” Alexa up, you click the
‘start listening’ button and, after
you hear the “ding”, speak your
question or command. When
finished, you can click that button
again to have it stop listening and
process your command, or you can
let it timeout (about 5 seconds)
then it will start processing. Many
people are working on headless
operation (no monitor) and a
physical button connected to a
GPIO pin, and some are actually
working on the “wake” word
option. You can find more
information in the issues section.
• You should (read MUST) use a
decent quality SD card. My
suggestion is to get nothing less
than a Class 1 0 card that is no
full circle magazine #1 08

smaller than 1 6 Gig.
• As soon as you boot into the new
operating system for the first time,
run a ‘sudo raspi-config’. Be sure to
enlarge the file system to take in
the entire card. Be sure to turn
SSH on. You will need to reboot
here. Next you should then do a
‘sudo apt-get update’ and then a
‘sudo apt-get dist-upgrade’ so you
are at the latest software
revisions.
• There are some steps that
require you to enter certain data.
Make notes of what you entered,
either by a screen shot, into your
smartphone, or (HORRORS!!!!!!) on
paper. It will make things easier.
• If you have any problems, check
the issues section. More than likely
someone has already had the same
problem and there might be a fix.
• Print the web page with the
instructions and work off the print.
This way, you can check off those
steps you have already completed.
Especially helpful if you get
interrupted.
• You can find more information,
and change certain settings, at
alexa.amazon.com. I understand
that some people who are not in
the USA have problems with this
site.
I think that’s enough for this
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month, but next month, we will
turn our RPi into a thermometer.
The neat thing about using the
DS1 8B20 sensor is that you have
more of them on a single line. This
way, you could use one in the living
room, one outside, etc. We’ll use
these sensors later on with the
Arduino and be able to use the
arduino as a remote device so we
don’t have to try to run a long
cable and change the resistance to
a point that it won’t work.
Until next month, enjoy
checking out the Alexa project,
and, if you try it / them, hope you
have success.

Greg Walters is owner of RainyDay

Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1 972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.
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Li breO ffi ce Pt.5 9 - D ocu m en t Fi eld s

Written by Elmer Perry

document properties" to have
LibreOffice to automatically apply
information like the name as
author to the document properties
U SER D ATA
of new documents. Any changes
User Data is information about you make to the User Data takes
effect only after you restart
the author (or user) of the
document. You can access the User LibreOffice.
Data at Tools > Options >
D OCUMENT D ATA
LibreOffice > User Data. If you
have never filled out this
The Date and Time fields allow information, it is blank. Text boxes
There’s a wealth of fields
you
to
insert
the
current
date
and
related to the document itself.
are provided for first, last name
COMMON FIELDS
time. We saw a good example of
and initials, as well as full address, Some of them are listed in the
using
the
date
and
time
fields
in
title, phones, fax, and email. If you common fields under Insert >
A group of fields are available
the
last
issue
(Full
Circle
1
07)
in
my
Fields. Some of the information,
are in a company environment,
directly through the menus, and I
article
on
Auto
Text,
but
they
are
there is also a box for the company like word count, page numbers,
call them the common fields, since also useful in templates and
name. Check the box "Use data for page count, changes as the
some developer decided they were master documents.
the most used. They are located
under Insert > Fields. The fields are
To insert the common fields,
Page Number, Page Count, Date,
just select them from the menu
Time, Title, Author, and Subject.
Insert > Fields.
You will see later where the Title,
Author, and Subject fields are set.
ften, when creating a
document, you find the need
to insert information about the
document into the document. You
can use LibreOffice fields to get
information like page number,
total pages, title, author, word
count, etc. With minimal setup, you
can insert the information into
your document, and the fields will
update as their values change.

The Page Number is related to
the current page on the current
document, while the Page Count is
the total number of pages in the
document. These fields are handy
because they can change from the
time you enter them. You might

insert a page before the current
page. Without the fields, you
would have to go through every
page after the insert and renumber
the pages. Using the fields, the
page numbers will adjust
automatically. The same is true of
the page count. As you edit, you
might increase or decrease the
total number of pages.

the document properties. Each
provides reusable information.

M ETADATA

Before we dive further into
document fields, we will look at
the places where much of the
information used by the fields is
stored. The two main sources for
the information are ‘user data’ and
full circle magazine #1 08
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document is edited and revised.
Other options like the title and
subject are added by the writer or
editor of the document. The
document fields are located in the
properties of the document, File >
Properties.
The General tab shows us a
wealth of information that we
can't change from this dialog. You
can see the file name and its
location, as well as its size,

creation, and last modified dates.
At the bottom of the tab, you find
a check box labeled "Apply user
data." When checked, it saves the
user's full name with the file. The
name used is the one in the User
Data mentioned above. The
revision number is nothing more
than a count of the number of
times the document has been
saved. If, like me, you save often,
this number ticks up quickly. The
Reset Properties button will reset
full circle magazine #1 08

all the dates, modifications,
author, and revisions to the
current state. The current user
becomes the author, the created
and last modified fields change to
the current date and time, and
revisions is set to 1 .

consistency in your document. You
have text boxes for the title,
subject, keywords, and comments.
These inputs are where the fields
look for this information, so this
tab is key to using fields like title
and subject.

The Description tab is where
you provide the basic information
about the document. If you are not
in the habit of using this, I
recommend giving it a try. You can
use this data to maintain

The Custom Properties tab
allows you to create your own
properties for the document. For
example, when creating a
document, you need to create a
header entry on each page with
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your last name and a shortened
title. To create this custom field,
click on the Add button. You get
entry boxes for Name, Type, and
Value. You can click on the arrow
for the Name and see some
predefined suggestions for field
names or fill in your own. You
won't find any that meet our
needs, so you type in "Short Title"
for the name. There are six
different types, Text, DateTime,
Date, Duration, Number, and Yes or
No. In this case, you are just adding

a text property, so you select Text.
In the Value text box, enter your
last name and short title. For
example, "Perry/LibreOffice 59."
Click OK when you are finished
adding custom properties.

D OCUMENT FIELDS
While LibreOffice gives you
quick access through the menu to
Title, Author, and Subject, dozens
of other document fields are
available. They are located in the

full circle magazine #1 08

fields dialog. You access them
have options for Chapter, File
under Insert > Fields > More Fields. name, and Page. Sender gives you
a list of all the data from the User
On the Document tab, you have Data in the LibreOffice options.
general information. While some
Statistics allows you to insert
of the common fields are here like tallies on different elements of the
Title, Date, and Time, you can do
document: pages, paragraphs,
more with them here than you can words, characters, tables, images,
by just selecting them from the
and objects. Templates lets you
menu. When you select the Author, insert information about the
you discover you can insert the
template used to create the
name or just the writer's initials.
document.
Selecting Date or Time gives you a
wealth of formatting options. You
The DocInformation tab
contains even more fields about
the current document. You can
insert the Comments, as well as
the Keywords, from the
document's properties. There are
fields for when the document was
created, last modified, and last
printed – with options to insert the
author, time, and date of the
creation, modification, or printing.
Subject and Title show up here as
well. The Revision number, as I
already mentioned, is just the
number of times the document has
been saved. The "Total editing
time" is just that, the total amount
of time you have spent with this
document open. You can select
several formats for this field
depending on how you want it to
display. Might come in handy if you
need to report how long you spent
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creating and editing a document.
You will also find your custom
created properties here under
Custom.

Once you select any of these
fields and the related options, you
can click on the Insert button to
insert them into your document. If
any changes occur, the fields will
automatically update. If you need
to use one of the fields from the

dialog often, you can create an
Auto Text – the way you did in part
68 for the Journal Entries (Full
Circle 1 07). Also, the keyboard
shortcut for the fields dialog is
CTRL-F2.
Finally, I'm sure you have
noticed that fields get highlighted
in gray. The highlighting does not
show when you print the
document. You can control

whether or not the shading shows
at Tools > Options > LibreOffice >
Appearance. You can change the
color of the Field Shadings option,
or uncheck it to prevent it from
showing. To quickly turn the
shading on and off, select View >
Field Shadings from the menu, or
press CTRL-F8.
Using LibreOffice fields, you
can insert information about your
document directly into the
document, and have those fields
update as they change. Besides the
common fields, you will find
statistical fields, fields about the
author, fields about the document,
and you can even create your own
fields. To create quicker access to a
field formatted a certain way, you
can create an Auto Text entry with
a shortcut to access the entry.

Elmer Perry's history of working,

and programming, computers
involves an Apple ][E, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.
He blogs at
http://eeperry.wordpress.com

full circle magazine #1 08
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Written by Theo van Oosten

n the early days of computers, a
company called Digital
Equipment Corporation (DEC)
created its 32-bit VAX computer
using openVMS as its operating
system. Because a VAX/VMS
computer is so reliable, there are
today - after more than 25 years still a large number of them in use.
But, in the end, even these reliable
computers will have to be
replaced. As described in part 1 ,
you could migrate from VAX/VMS
to Linux, as the way Linux works is
largely compatible with VAX/VMS.
If you use Pascal as your
programming language, you will
find that Lazarus/Free Pascal is a
good replacement. But there are
technical functions used in VMS
with no apparent replacement in
Linux. In this article, I will, among
others, describe how to replace
mailboxes, and deal with file
version numbers and packed arrays
of char (strings).

M AILBOXES
For IPC (interprocess
communication), VMS offers

M i g ra te From VAX/VM S To Li n u x Pt.4

mailboxes. In Linux, there is a
perfect replacement, only the way
you create and use them is very
different:

above mentioned table.

to get the unique key. Whichever
method you use, the created
In Linux you have to get a key first. mailbox will be permanent. In
In the examples from the
Linux there are no temporary
documentation, they use the
mailboxes. So be aware of that
• To create a mailbox in VMS, you
function ftok (file-to-key) for that. when starting a new session; you
call $CREMBX (handle,
You pass the file specification of an might get old messages left in the
logical_name, permanent). The
existing file, plus a small number
mailboxes from a previous run.
identifier of the opened link to the between 0 and 255, to this
(new) device named MBAxxxx
function, and it converts this to a
• Now you are ready to send and
(xxxx is a number between 0 and
large number, the key. If you hand receive messages. To send data in
9999) is assigned to “handle”. By
over the same file and number, you VMS, you would fill a buffer with
using the boolean argument
will get the same key. This might
data and make a call to $QIO(W)
“permanent”, VMS is told to create suggest that this file will contain
(see part 2) using the handle of the
a mailbox that will still exist after
the content of the mailbox, but
mailbox you want to put the
all processes linked to that mailbox that's not true. The file is only used message into, a pointer to the
are gone (otherwise, it will be
to get a unique key. The meaning
buffer, and the size of the buffer
deleted and the content is lost).
of this file can be compared to the (plus an eventflag, see part 2). To
The given logical name (for an
logical used by VMS.
receive data, you would make the
explanation of logicals, see part 3)
same call to $QIO(W), only the
is used to see if the mailbox
Now you can create or link to a
function specifier would be “read”
already exists. VMS will look for it mailbox using this key as the
instead of “write”. On return, the
in the table
identifier to get a handle. So you
buffer will be filled with the
LNM$PERMANENT_MAILBOXES or can use two methods: Either create received message, and the size
LNM$TEMPORARY_MAILBOXES,
a dummy file for every mailbox you parameter will be filled with the
depending on the value of
want to use and always use 0 as
size of the received message.
'permanent'. If found, the logical is the small number, or use, e.g., the
'translated', and the mailbox it
folder at the base of the current
To send data in Linux, you would
points to is referenced; if not, a
version of your project (see part 3) fill a buffer just like in VMS, but
new mailbox is created and the
to get separate mailboxes for
there must be an extra integer at
logical - pointing to the newly
every version and assign a constant the beginning of the buffer. This
created mailbox - is created in the (smaller than 256) to every mailbox integer value must be filled with a
full circle magazine #1 08
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number not being zero! Then you
would call sndmsg() with the
handle, a pointer to the buffer, and
the size of the buffer – not
counting the extra integer! To
receive a message, you would call
rcvmsg() with the same
parameters plus a message
identifier. This message identifier
is used to filter the messages sent
to you, so you get only the
messages with the matching
number in the extra integer value.
If the message identifier is zero,
there will be no filtering. For
example: suppose there are five
messages sent to you: message A
with that extra integer set to 1 , B
with 2, C with 1 again, D with 3,
and E with 2 again. If you start
rcvmsg (...., 2), you will get
message B first and then message
E. Then rcvmsg (..., 3) will retrieve
message D, and, eventually,
rcvmsg (...., 0) will get the rest: A
and C. If rcvmsg (...., 4) is issued, no
messages will be returned. The
message size, again not counting
the extra integer, is returned as
the result of the function.
Another difference is that, in
VMS, you must specify the total
size of the mailbox when you
create it. In Linux the size is fixed.
This might be a problem when

using large, or a huge number of,
messages.

to or created using the key, and
the handle is returned.
• The _QIO(W) will send or receive
depending on the function
THE IMPLEMENTATION
specifier. It uses a new thread and
the specified eventflag to create
In the beginning, I simply
the asynchronous behavior as in
replaced every reference to
mailboxes with the corresponding VMS (see part 2).
This way, the only thing you
Linux calls. I used the specified
logical as the name of a dummy file would have to do for the migration
is define the above mentioned
in a dedicated folder to get the
unique key. For a small project, this dedicated logical and add the extra
integer in front of the declaration
would be acceptable, but this is
not the intention of this migration of the buffer. Removing the logical
used for a mailbox would cause the
tool. So I created the functions
_CREMBX and _QIO(W) to behave creation of a new mailbox upon
opening, while the still connected
the same as in VMS. (A “$” sign is
processes would use the old one,
not allowed in names when using
exactly like in VMS.
Free Pascal, so my conversion
program substitutes the “$” by an
underscore. The same problem
FILE VERSION NUMBERS
arose when using the terminal, I
will discus this in part 5 about
This part is about file systems:
DCL).
In the beginning, there was DOS
• _CREMBX uses a dedicated logical (and CP/M) which used FAT as its
to point to a file containing info
file system. File names were 8
about assigned numbers. This file
characters long with a file type of 3
is also used for creating the unique characters. Later, NTFS (New
key. _CREMBX assigns a free
Technology File System) offered
number in the range 0-255 if the
long names and types,and more
mailbox does not already exist. The attributes for better security. They
given logical in table
were both using assigned drive
LNM_PERMANENT_MAILBOXES is letters to identify the device (disk).
used or created just like VMS
In Linux, most of the time “Ext” is
would. Then the mailbox is linked
used as its default file system,
full circle magazine #1 08
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currently Ext4. As mentioned in
part 3, Linux does not use assigned
drive letters, but mounting points.
From a functional perspective,
that’s the only difference to
FAT/NTFS.
When DEC created ODS-2 (On
Disk Structure version 2), it took a
different approach. They named all
devices (not just disks) with two
characters to specify the type, one
character starting with A, then B
and so on to identify the adapter,
plus a serial number. The base
folder (directory) on a disk is
named [000000] and names and
types of files are long like in NTFS
and EXT. And they decided that
there should be more versions of
the same file in the same directory
(folder). An example:
Suppose I create a text file with
an editor and save the file. Besides
the name and type that I specify, it
will also get a version number,
starting with “1 ”. If I would use the
editor to change this file and save
it again, the existing file will not be
overwritten like in Linux and
Windows. The editor creates a new
file, with the same name and type,
but with a higher version number,
“2” in this case. The same happens
with log files, executables
contents ^
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(programs), and so on. The
advantage is that you can see the
history of a file and even restore a
previous version. For example, if a
new version of a program does not
work as it should, you can just kill
the process and start the previous
version, it is still there (unless you
deleted it). But of course there is
also a down-side: For a thousand
versions of a file, you need a
thousand times the disk-space and
the version is limited to 32767. If
you go beyond that, the creating
program will crash!

If your project is depending on
this behavior (the file version, not
the crashing), you will have to
change your programs. Either by
adding a “version number” to the
name or type, or by changing your
project in such a way it will no
longer depend on the file versions.
Whichever solution is best
depends on the project and there's
no single solution that fits all
possibilities.

PACKED ARRAY OF CHARS
In Free Pascal, two worlds
collide. On the one hand are the Ctype strings, and on the other the
Pascal-type strings. C-type strings

are either a pointer to a datastructure which can dynamically
change in size, or a data-structure
of fixed size, starting with a byte
containing the length of the string.
Both contain a zero terminated
number of characters. Pascal-type
strings are essentially just another
fixed size array, without the
terminating zero. In VAX-Pascal,
there is a variant that uses a length
word in front of the array
(VARYING OF CHAR), but Free
Pascal does not recognize the
keyword VARYING. You will have to
use fixed size C-type strings to
replace a VARYING, but the
behavior is not exactly the same.
For this type of strings, the
migration will need some work.
Big problems arise when you
compare two strings with at least
one of them being a packed array
of chars. In VAX-Pascal, the
remainder of a packed array of
chars will be filled with spaces, in
Free Pascal the remainder is
unknown! As a result, comparing
even fails if the strings you use are
equal. Suppose you have a packed
array of chars with size 1 0 ([1 ..1 0])
named STR. Now fill it with a text
of size 4 like “STR := 'test';” and
compare it with the same text: “IF
STR = 'test' THEN …. ELSE …..”.
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Both should be equal, but it will
execute the ELSE part! This is a
problem for a constant type of
string, but it will also fail if you use
a C-type string to fill a packed array
of chars.
This is clearly a bug, but I didn't
have the time to fill out a bugreport.
As a workaround, you could add
a string of spaces with the same
length as the size of the packed
array of char, because Free Pascal
will not complain about the string
being too long. It just truncates it.
So “STR := 'test' + '
';” would
fill the remainder with spaces as in
VAX-Pascal, but this must be done
with every assignment concerning
a packed array of chars! You also
have to do something similar when
comparing. Lots of work to get
around this behavior, so it might be
easier - if possible - to switch to
another type of string. But then
there will be problems with code
depending on the size of the
packed array of chars, being not
the size of its contents.
There will be also problems
when assigning a C-type string
from a packed array of chars. If the
remainder of the packed array of
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chars are zero's (usually the case)
the contents of the string will list
as “test” in the above example in
the debugger, but the length of
the string will be 1 0, so a
comparison to “test” will fail. In the
debugger, it looks like they are the
same, but still the “if” statement
will execute the “else” part. It took
me days to figure that out. It
shows an inconsistency in the way
Free Pascal handles strings, as the
terminating zero is ignored. Worth
a bug report!

Next month : In the next article, I

will go more in-depth about DCL
(Digital Command Language) – the
interface used by Digital when
interacting with the terminal, and
AST's (Asynchronous System Trap),
also named ‘call back routines’,
and, related to that, catching the
signals as a result of pressing ^C,
^Y, ^T or ^Z.

After keeping VAX/VMS systems
running for 30 years, Theo needed a
new challenge and started from
scratch with Linux to re-do every
mistake he made all over again. You
can email Theo at:
info@theovanoosten.nl
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La TeX: Th i n ki n g O u tsi d e Th e Cell

Written by John Eddie Kerr

ast year, I created a member
directory for the Ontario
Courthouse Library Association, of
which I am a member. Since all of
the information is in a
spreadsheet, I thought that it
would not take too long to make a
nifty little membership directory in
LaTeX that was formatted to look
good on a computer screen, tablet,
or a smartphone; in short –
convergence ready.
You may have data that is in a
database or spreadsheet that you
would like to extract and display in
a different format. LaTeX can
display fantastic looking tables if
you want to do that. The more I
worked on this and made Google
searches on LaTeX and CSV, I found
out just how versatile LaTeX can be
with a CSV file. But for now, I want
to create a directory from data in a
spreadsheet.
Since my data was in a
LibreOffice Calc file, I clicked on
File > Save as > All Formats BOX >
Text CSV (.csv). With the aid of
search and replace in my text
editor, I was able to eliminate all of

\textbf{Wellington County Law Association}\\
74 Woolwich Street Unit D\\
Guelph, ON N1H3T9\\
\href{https://www.openstreetmap.org/#map=17/43.54695/-80.24834}{Map} \\
519-763-6365\\
1-866-893-5220\\
519-763-6847 (fax)
\textit{{\tiny Call before you send a fax}}\\
\textbf{John Eddie Kerr}\\ Mon-Thur. 9:30-1:30\\
\href{mailto:lawlibwell@gmail.com}{lawlibwell@gmail.com}.\\
\index{Wellington LA}
\index{John Eddie Kerr}
\newpage

the commas by replacing them
with a space. Then, after creating a
preamble in my LaTeX editor, I
copied and pasted my data into a
LaTeX file and proceeded to insert
the LaTeX code, line by line, until
my data looked like that shown
above.

finished product was a success
there had to be a faster way to do
this. I was working to make the
code easier to read for humans,
which is good, but what if LaTeX
and my computer did not need it to
look that way?

Before we go any further, do a
search and replace on the entire
file replacing any commas with a
bar “ | ” and a space before and
after it. This is to give a new
separation character between city
and province so that “Guelph, ON”
becomes “Guelph | ON”.

Let's go back to the spreadI did not think that it would take sheet, and, for the purpose of this
Into the cells, type in the code
article, we will just look at the first needed for each line of text
a long time to do this, but, as it
three columns, and insert an empty (shown below).
turned out, this ended up being a
column to the left of every column
lot of typing, heck, it had way too
many line returns. Even though the so it looks like the image above.
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Cell A has the code to begin the
boldface format command
“\textbf{“, cell C has the bracket to
close the format code command
started in cell A “}” with the line
break code added as “\\”. Cells E
and G have only line break code
“\\”, but they could have more – for
now I want to keep it simple.
Save this as a .CSV file and open
with a text editor and it should
look like this:
\textbf{,Wellington Law
Association,}\\,74 Woolwich
St.,\\,Guelph | ON N1H 3T9,\\

Do the following search and
replace steps:
• replace each comma with a space
• replace the “{ “ with “{“ so that
the “{ Wellington looks like
“{Wellington
• replace the “ | ” with a comma.
(It works in gEdit, but it did not in
Geany for some reason.)

needed code for your file very
quickly, for each column, instead of
line by line like I did the first time
around. You can start off by
experimenting with a file made up
of one row of data until you are
happy with it, and then copy the
code into the full data file.
After the data is manipulated to
look pretty, press Ctrl A to select
all, Ctrl C to copy, and then paste it
into a file that holds your preamble
and then save the file as a .tex file.
Then process it through your
favourite LaTeX editor. To see what
we can end up with, here is a page
from the directory I made:

\documentclass[10pt,letterpaper]{report}
\usepackage[paperwidth=3.5in, paperheight=4.5in]{geometry}
\usepackage[latin1]{inputenc}
\usepackage{graphicx}
\setlength{\parindent}{0pt}
\usepackage{hyperref}
\usepackage{makeidx}
\makeindex
\begin{document}
\begin{titlepage}
\textbf{OCLA Directory}\\
as of \today
\end{titlepage}
\newpage
DATA GOES HERE (as above)
\end{document}

There are many different
methods to take tabular data and
process it in a table format. I want
to emphasise that this process is a
method to take spreadsheet data
and display it in a non-tabular way.

\usepackage[paperwidth=3.5in,
paperheight=4.5in]{geometry}

sets a page size that is ideal for
hand-held devices

\setlength{\parindent}{0pt}

stops automatic paragraph indents

\usepackage{hyperref}
If the data that you have is in
another program such as an e-mail allows the use of hyperlinks for eclient's directory, you can probably mail and web pages
export the data as a CSV file and
then import it into a spreadsheet. \usepackage{makeidx}

We end up with this:
\textbf{Wellington Law
Association }\\ 74 Woolwich
St. \\ Guelph, ON N1H 3T9 \\

\makeindex

Let’s highlight some of the code This lets us index data on an index
I used to make this directory.
page with the \index{ } command

The advantage of entering
LaTeX code this way is that you can
copy and paste or paint the

Here are some comments on
the nifty code in the preamble:
full circle magazine #1 08
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And in the data itself:
\newpage

I added this to the end of every
row, resulting in one record per
page.

Until next time, enjoy exploring
LaTeX.
I've also created a YouTube
video explaining this procedure:
https://www.youtube.com/watch?v
=IBb5wdwACKg

THE O FFICIAL FULL CIRCLE APP FOR U BUNTU TOUCH

B

rian Douglass has created a

fantastic app for Ubuntu Touch
devices that will allow you to view
current issues, and back issues, and
to download and view them on your
Ubuntu Touch phone/tablet.

This process turns LaTeX into a
very fast and powerful tool for
displaying spreadsheet data in a
non-tabular way. It was one of
those “A HA!!” moments when I
realised that we do not always
need to create a LaTeX source
document that caters to the
human eye, even though we create
a beautiful looking document with
code that looks like a dog's
breakfast.

I NSTALL
Either search for 'full circle' in the
Ubuntu Touch store and click
install, or view the URL below on
your device and click install to be
taken to the store page.
https://uappexplorer.com/app/
fullcircle.bhdouglass

However, after we produce a
document this way, it may be
advisable to keep the spreadsheet
file that contains the LaTeX code
as this will make it easier to edit
the information at a later date. The
code that we create this way does
not look pretty in the LaTeX editor,
but the end results look great.
As for writing tables in LaTeX
from spreadsheet data, LaTeX has
all kinds of tricks in the lion's den
and I will look into that next time.
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I n k s ca p e - P a r t 4 8

Written by Mark Crutch

f there's one word that can stir
up controversy amongst
experienced Inkscape users, it's
“filters”. Attitudes range from
“they're bitmaps, and therefore
bad”, through “it's easier to add
filters to your image in GIMP”,
right up to “filters are great”. I'll go
on record as putting myself in the
last group, but I would definitely
extend the statement to add “(if a
little slow and clunky)” to the end
of it. So what are filters, in
Inkscape terms? And why are they
so divisive?
In short, filters are part of the
core SVG specification that offer a
way to perform bitmap operations
on your vector objects. Filters
consist of a number of “filter
primitives” that can be linked
together to create a “filter chain”
that produces the desired effect.
They apply at the point that your
elements are being rendered to a
bitmap for display, export or
printing, and operate at the same
resolution as the output device.
So, although they are pixel-based,
they can be just as crisp and
scalable as the unfiltered vectors

in your drawing. It does mean,
however, that they are purely a
display feature and have no effect
on the underlying geometry of
your image – so they're of no use
to anyone trying to produce
drawings for use on a vector
output device such as a vinyl cutter
or laser engraver.
Filters are also “live”. You can
tweak and modify the parameters
used in your filter throughout the
life cycle of your drawing, whereas
filters in a bitmap editor like The
GIMP are usually fixed and
permanent once they've been
applied. This is both a blessing and
a curse: SVG filters are incredibly
flexible because you can change
them as you go along; conversely
they eat up a lot of processing
power as they need to be recalculated not only when you
change their parameters, but
potentially each time you pan or
zoom. The performance penalty
can be severe, especially when
zooming far into your drawing,
leading some users to avoid filters
entirely, although the worst
problems can usually be avoided
full circle magazine #1 08

by using a few simple techniques
that I’ll describe in a future article.

give it a nice bright fill color, then
add a little blur using the slider in
the Fill and Stroke dialog.

Finally, filters are rather
unintuitive – and Inkscape's UI for
editing them only makes this
problem worse. The developers
have included a great set of
predefined filters, which was
improved further in 0.91 , but it's
still useful to understand how to
use the editor in order to tweak
and extend them. So let's start by
taking a look at the editor courtesy
Now open the Filter Editor
of the most common filter
using the Filters > Filter Editor
primitive: Gaussian Blur.
menu entry. If it opens in a pane
within the main Inkscape window, I
Gaussian Blur (or just “Blur”
suggest dragging it out as a
from now on) is the most
separate floating dialog. This will
commonly used primitive –
let you resize it to give you more
principally because it’s exposed
space to work with – filter chains
directly in the Fill and Stroke
can quickly become long and some
dialog. Many people happily use
of the primitives have a lot of
the Blur slider in that dialog
parameters to tweak.
without ever going anywhere near
the full Filter Editor, but it also
provides a convenient mechanism
for creating a “stub” filter chain
that you can develop further. Of
course you’ll need an object (or
group) to apply your filter to, so
begin by creating a text object,

28

contents ^

HOWTO - INKSCAPE
The left of the editor is given
over to a list of the filters in your
document. Assuming you started
with a blank drawing, you should
see only a single entry here, given
an automatically generated name
along the lines of “filter1 234”.
That entry will have a mark in the
checkbox, indicating that it’s the
filter that’s in effect on the
currently selected object. If you
want to apply the same filter to
another shape, just select that
object in the canvas window, then
check this box in the editor; you
can use a single filter chain on
multiple elements – which is useful
when you want multiple text
objects to share a single drop
shadow, for example. Finally, in
this section you can create a new
filter from scratch using the “New”
button at the bottom, or right-click
on a filter entry to duplicate or
remove it completely. You can also
rename it from that context menu,
but it’s usually easier to just
double-click on the filter’s name
and enter a new one. Giving
slightly descriptive names to your
filters makes it easier to keep track
of the important ones as your
drawing develops. For now, why
not rename “filter1 234” to “Blur”?
With your filter selected, you

should see a single entry in the list
on the right of the dialog: Gaussian
Blur. This is your filter primitive,
and it’s this list that’s used to stack
and combine primitives into chains.
For now, click on the Gaussian Blur
entry to select it, and then look to
the bottom of the dialog where
you’ll find its parameters. Gaussian
Blur takes two parameters, but by
default Inkscape locks them to the
same value via the “Link” button to
the right. By toggling that to unlink the parameters, you can
provide different values for
horizontal and vertical blur,
providing the opportunity for
“motion blur” effects that make it
look like your object has moved in
one direction. Note that the scales
are labelled in units of “Standard
Deviation”, whereas the slider in
the Fill and Stroke dialog shows a
percentage value. The former is
used in the SVG spec, whereas the
latter is probably more
understandable for users who just
want to add a little blur without
going near the filter editor. Suffice
to say that the two fields are just
different representations of the
same underlying value, so the fact
that they usually hold slightly
different numbers isn’t really a
problem.
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If you're still on 0.48, and drag
the sliders to the right, you may
notice that the blur on the text
starts to get cut off at around the
20% mark, and by the time you
reach 50% it’s become a ghostly
rectangle. You’ve just encountered
one of the most common problems
reported by users who take their
first steps into filters, but don’t
worry, it’s an easy one to fix. In
principle, some filters – including
Gaussian Blur – could continue off
into infinity: mathematically
speaking, a blur represents an
infinite series of calculations,
although the results quickly drop
off to the point that the calculated
values have no visible effect on the
drawing. Obviously performing an
infinite series of calculations isn’t
possible for even a high-end
machine, so the SVG spec allows
for a window or cutoff to be
defined, beyond which the
rendering engine shouldn’t bother
performing any more calculations.
By default this cutoff is set to
allow a 1 0% margin all around your
filtered object, which is fine for a
small blur, but clearly not enough
as the blur value increases.
The cutoff is adjusted via the
“Filter General Settings” tab, and,
as the name suggests, it affects
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the whole filter, not just the
currently selected primitive. Within
this tab you’ll find two sets of
parameters, labelled “Coordinates”
and “Dimensions”. The former sets
the position of the top left of the
filter window, relative to the width
of the object. The default values of
-0.1 0 mean that the cut-off
rectangle starts 1 0% up and to the
left of the object’s bounding box.
The latter pair of values sets the
width and height of the filter
window, so the default value of
1 .20 results in a cut-off that’s 20%
larger than the bounding box.
Because the Coordinates fields
have offset the window by 1 0% to
the top left, the result is a cut-off
that symmetrically surrounds the
original object with a 1 0% margin.
To use a large Gaussian Blur value,
you might want to increase this
window to give you a 50% margin
all round: that would entail setting
the Coordinates to -0.50 and the
Dimensions to 2.0. Most of the
time you don’t need to adjust
these values, but when you start to
see your filtered objects being
unexpectedly cut off at the edges,
the Filter General Settings are
almost always the cause.
In the copy of 0.91 on my
machine, this problem seems to
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have been addressed by
automatically modifying the
settings to sufficiently encompass
the blur. However I can find no
mention of this change in the 0.91
release notes, so it's not clear if
this only applies to blurs or simple
filter chains, or if the algorithm
being used is robust enough to
handle complex chains as well.
Therefore I recommend
familiarising yourself with this tab,
even on 0.91 – though with luck
you'll never have to use it.

Before moving on, it’s worth
having a quick recap to make sure
you’re clear about the dialog so
far. On the left is the list of filter
chains, each with a checkbox to
apply it to the currently selected
object. From here you can create
new chains (though just adding
some blur to your object has a
similar effect), and manage
existing ones. On the right is the

list of filter primitives that
constitute your filter chain –
though so far we’ve only dealt with
a rather short chain consisting of a
single primitive. At the bottom of
the dialog is a tab for the currently
selected primitive’s parameters,
and another for setting the filter
cut-off window position and size.
Now, let’s move back to the list
of primitives that we so quickly
glossed over previously. Looking
more closely at the Gaussian Blur
entry you’ll notice that the
“Connections” section contains a
barely visible triangle, from which
is emanating a line that connects
to a column on the right with a
“Source Graphic” label running
vertically down it. The triangle
represents an input into the filter
primitive, and the column is one of
several possible sources for that
input. Unfortunately, of the six
inputs shown in the UI, two of
them require special treatment
(and will be covered in a future
article), and another two don’t
work at all! Of the two that do
work, the “Source Graphic” column
is exactly what it sounds like – it’s
used to ‘inject’ a bitmap
representation of the selected
object into the filter chain. The
“Source Alpha” column is used to
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inject a bitmap representation of
the object’s alpha channel with
solid black pixels representing
opaque parts of the object,
transparent black pixels for the
transparent parts, and translucent
black pixels for those parts that
are somewhere in-between. In
other words, it injects a blackened
silhouette of the object.
As well as having the triangular
input nodes, each primitive also
has a single output. There’s no
obvious output node, instead it’s
the bottom edge of the primitive
that acts as the output in the
Inkscape UI. It’s possible to
connect the bottom of one
primitive to the input triangles of
other primitives, thus building a
chain, but the output from the last
primitive is always used as the
output from the chain as a whole.
Let’s build on our Gaussian Blur
to create a simple drop shadow
filter. During this process, you’ll
learn how to link primitives
together to form a chain, and
hopefully begin to understand a
little more of the power of filters.
Start by renaming your existing
filter to “Drop Shadow”, re-link the
parameters if you need to, and set
the blur to a fairly small number –
enough that you can clearly see it
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applied to your object, but not so
much that the it just turns into a
fuzzy cloud. A value of 2-3 should
do the trick.
Our shadow is going to be dark,
made of translucent black pixels,
so the first thing to do is to
generate a silhouetted version of
our object to pass as an input to
the Gaussian Blur primitive. But, of
course, we already know of a
source of silhouettes – the Source
Alpha column. In a slightly back-tofront operation, we can link this
source to the Blur’s input by
clicking and holding on the
triangle, then dragging the mouse
to the Source Alpha column before
releasing (yes, you drag from input
to source, rather than the other
way around). If all went smoothly,
the line that previously ran to the
Source Graphic column has been
replaced by one to the Source
Alpha instead. Take a look at your
text object and you should find it’s
turned into a blurry black version
of the original.
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other, honouring any transparency
they may have in the process. The
first input goes at the bottom of
the stack, the last input at the top,
so we need to add the offset blur
first and the original source
graphic second.

relative position. Then edit the
smattering of bitmap magic on
text itself. Each change you make
your vector objects.
If we were to display the
takes
place
live,
and
you
can
reoriginal over the top of the blurred
open the filter editor at any time
alpha version, you would just see a
to make further changes. Try
halo of darkness around your text.
creating a “hard” drop shadow by
To make it work as a drop shadow
merging an offset Source Alpha
we need to offset our blurred
with the Source Graphic, but
image from its original position
Begin by clicking in the Merge
without using the Gaussian Blur. Or
using the imaginatively titled
filter’s sole input triangle and then, try a bit of motion blur by un“Offset” primitive. Select it from
linking the horizontal and vertical
the pop-up list just below the filter holding the mouse button down,
sliders; adding some horizontal
chain, then click the adjacent “Add drag to the triangle in the row
above (the Offset filter). Release
blur and a horizontal offset; then
Effect” button to add it to your
the button and you should see a
merging with the Source Graphic
chain. It should automatically be
connection
made,
running
from
the
again.
connected to the output of the
base of the Offset to the input of
Blur, as indicated by a small line
the Merge. You’ll also notice that
running from the triangular input
of the Offset to the bottom of the the Merge filter has gained a
second input triangle. Click and
Gaussian Blur. Adjust the new
drag from this second triangle to
primitive’s Delta X and Delta Y
the Source Graphic column. Check
parameters to shift your shadow
down and to the right – a value of the canvas, and you should now
have a glorious drop shadow. See,
6.0 in each is a good start.
filters aren’t so tricky… right?
The final step in creating our
filter is to add the original graphic
back on top of the blur using the
Make sure you understand what
Merge primitive. Once again you
we’ve covered in this instalment,
should select it from the pop-up
because, next time, we’ll build on
list and add it using the Add Effect
this simple drop shadow to
button, but this time it won’t be
Mark uses Inkscape to create three
introduce
some
more
filter
webcomics, 'The Greys', 'Monsters,
automatically connected to the
primitives
that
will
expand
your
Inked' and 'Elvie', which can all be
rest of the chain. The Merge filter
found at
Now tweak the Gaussian Blur
repertoire further, giving you the
combines multiple input images by
http://www.peppertop.com/
and Offset parameters to change
capability to achieve effects that
stacking them on top of each
the softness of your shadow or its just aren’t possible without a little
full circle magazine #1 08
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Th e Brewd u i n o Pt.2

Written by Ronnie Tucker

ot much left to do on the
Brewduino now.

I’ve added some LEDs just to
indicate what’s going on. The
green LED is to show that the
device is on and OK. The red LED
shows that the switch is on and,
thus, the heat mat is on and
heating up the fermenting vessel.

Finally, the blue LED shows that
the switch, and heat mat, are off,
and that the vessel is cooling down
to room temperature.
The best way, I found, to test
the whole device is to have the
DHT22 under the lamp because,
when the lamp comes on, the heat
from the bulb will bring the
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temperature up and the whole
system goes into an on/off cycle.
The lamp heats the DHT, and when
it goes off, the DHT cools down,
the threshold is reached, and the
lamp comes back on again. And so
on.
The only adjustments to the
code are to define the LED pins:

33

int power = 43;
int red = 47;
int blue = 39;

Then, set the modes to output,
and put the (power) green LED on
(code is shown on the next page,
top right).
The temperature check
statement now includes the states
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ARDUINO - THE BREWDUINO
for the red and blue LEDs (code is
shown bottom right).

You’ll note that I’ve also fixed
the SSR state so that the light is
LOW (on) when the temperature is
below 24, and HIGH (off) when
above 24. This is the correct
procedure for the heat mat.

and working. Obviously, everything
will need to go in a nice box, and
the Arduino will need a power
supply (as I need my laptop!), but
everything is working, and that’s
the main thing.

No doubt I’ll be tinkering with
the code between writing this up,
and you reading it, but the code
referred to here is at:
Well, we’ve pretty much come
to the end of the Brewduino. Apart https://gist.github.com/ronnietuck
er/7fc62df1 61 1 071 1 6cf93, and
from swapping out the lamp for
the heat mat, everything is in place marked as revision 6.

pinMode(power, OUTPUT);
pinMode(red, OUTPUT);
pinMode(blue, OUTPUT);
digitalWrite(power, HIGH);

//
//
//
//

LED
LED
LED
power on LED

if (DHT.temperature > 24 ) {
state=HIGH;
// switch heat mat on
digitalWrite(red, LOW);
// heating on LED
digitalWrite(blue, HIGH);
// heating off LED
}
if (DHT.temperature < 24) {
state=LOW;
// switch heat mat off
digitalWrite(red, HIGH);
// heating on LED
digitalWrite(blue, LOW);
// heating off LED
}

If you can think of anything to
add/change in the Brewduino,
please feel free to email me your
suggestions:
ronnie@fullcirclemagazine.org

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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O p ti o n s

Written by S. J. Webb

n the past, I have reviewed
cloud-based distros. The
Chromebook is very difficult to
wipe from the SSD. There are
various means to incorporate
Ubuntu into the framework. The
first attempt was Chrubuntu,
Crouton, and the Gallium OS. I
purchased an Acer C720 to
experiment with Crouton and
Gallium. This hardware is known
for compatibility with Crouton and
Gallium. When I logged into the
Acer, the screen top was a perfect
duplicate of my Toshiba. Even my
Chromebook settings live in the
cloud, which is slightly unnerving.
Chrubuntu runs off a dedicated
USB or SD card. It acts like a

regular full operating OS. The
developer installed all of the
hardware drivers and items for
Chrubuntu. It is supposedly easier
to install. It appears to be an
abandoned project. You can find
instructions on how to install it on
the web. The Chrubuntu
community is thriving. Previously, I
installed Chrubuntu on an Acer
C71 0, and I was not impressed. The
trackpad was inactive and the
system seemed slow since it was
running from an SD card. Perhaps
at that time Chrubuntu was in beta
testing or my hardware was not
complementary. Chrubuntu works
as a true dual boot for the
Chromebook.
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Crouton uses a root
environment. This allows Ubuntu
to run parallel with the Chrome OS.
There would be no need to reboot
to move between the two
operating systems. It was easier to
get Crouton installed. There are
only three available DEs: Unity,
XFCE, and KDE. I attempted LXDE
and failed. My version had Ubuntu
1 2.04, there are ways to install
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1 4.04 for the root environment. I
followed the directions at
www.linux.com by Swapnil Bhartiya
on installing Crouton. David
Bennett at www.davebennett.tech
offers simple steps for the 1 4.04
installation. He also gives
instructions on how to install Kodi
to your Chromebook.
The Gallium OS just left beta
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testing. It is based on Xubuntu.
Gallium does not use a root
environment, but allows for dual
booting. The installation is well
documented. I was not able to
boot Gallium onto the Acer
Chromebook. It was a simple fix –
by modifying part of the Grub code
per the Gallium website (modify a
memory code line). However it
appears to be the most popular
method of putting Linux onto a
Chromebook. The Gallium
developers appear to be driven in
making this a successful OS.

A final option on a Chromebook
is to change the BIOS to SeaBios.
Only certain Chromebook models
can utilize SeaBios. This modified
BIOS enables a person to wipe the
Chrome OS off the Chromebook
and boot a Live USB to install
another OS. In some cases some
people are installing a Windows OS
despite the lack of mouse and
keyboard drivers. You can discover
this method from a single internet
query.
The past couple months I
reviewed the various cloud-based
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distros and Linux environments for
the Chromebooks. In my humble
opinion, there is an open source
solution to the closed Chrome OS
developed by Google. The solution
is not the easiest to implement
though. If a person wants to avoid
the Chrome OS, he or she should
purchase a cheap laptop, then
install Peppermint OS or Apricity
OS. However a person can learn
numerous items when installing an
open source solution. Every cloudbased distro offers perks and
problems during the course of OS
discovery.
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At the end of the day, I use a
Chromebook for the Chrome OS.
Ultimately, I want a simple,
reliable, and secure device. Linus is
a fan of Chromebooks and how it
brings Linux to the masses.

SJ Webb is a Linux Hobbyist and

Research Coordinator. He enjoys
fishing, hot rodding, and spending
time with his kids and wife. He
thanks Mike Ferarri for his
mentorship.
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Wri te For Fu ll Ci rcle M a g a zi n e

Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

document.

REVIEWS

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

G AMES/APPLICATIONS

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc). • Do not use tables or any type of
bold or italic formatting.

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the

Official Full Circle Style Guide :

http://url.fullcirclemagazine.org/7
5d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.
full circle magazine #1 08

When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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D ebi a n (N oroot) I n An d roi d

Written by Ronnie Tucker

Now you’ll have a fully working
Debian desktop on your Android
device!

ot everyone can get their
hands on an Ubuntu phone,
but now, if you have an Android
device, you can have Debian on
your phone/tablet!
Head over to the Google Play
store and search for ‘debian
noroot’ and it’ll come up.
Alternatively, click this link:
https://play.google.com/store/app
s/details?id=com.cuntubuntu

Once that’s done, you’ll see a
startup screen (with some
information). It’s a bit quick at
vanishing, but it’s reproduced
below to let you see the basic
commands.

By default, there’s no software,
to speak of, installed. So, click the
‘Terminal’ icon. To get the
keyboard up, you have to press
your device's ‘back’ button. The
first thing to do is update your
package list (by default, it’s
empty): Type:
sudo apt-get update

Click the INSTALL button and
wait. It’s a touch over 200MB, so it
may take a little while.

Then, to install a web browser,
enter:
sudo apt-get install
inceweasel

When the install is done, you’ll
see a Debian logo on your desktop.
Give it a prod to start the next
install. This will take a few minutes
– depending on your device.

Now we’re ready to rock!
I’ve only scratched the surface
of what’s possible with Debian
full circle magazine #1 08
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Noroot. Other folks have SSH,
GIMP, and all sorts of other stuff
installed on their Android devices.

THE FULL CIRCLE
WEEKLY N EWS

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.

A short podcast (<1 0min)
with just the news. No chitchat. No time wasting. Just
the latest FOSS/Linux/
Ubuntu news.

RSS:

http://fullcirclemagazine.
org/feed/podcast

full circle magazine #1 08
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Written by Charles McColm

everal years ago, I bought a
number of new components
from an online retailer only to
discover some of the equipment
was bad. I figured since the
hardware was new and in the
sealed packing when I bought it, I
wouldn’t have any problems.
Whether you’re building a new
system or refurbishing an old one,
it’s always a good idea to test your
hardware. Since hard drives are
most people’s permanent storage,
having a healthy hard drive is
almost as important as good
steady power to the computer.

Testi n g & Trou blesh ooti n g H a rd D rives

In the past, our refurbishing
project has used a few methods to
detect bad drives: The first method
was just listening to the drive. If
the drive sounded whiny (or had
the notorious click of death), we
either wiped the drive with DBAN
(Darik’s Boot and Nuke http://www.dban.org/), or took
apart the drive and sent it to our
end-of-life processor. The second
way we knew a drive was bad was
if it failed DBAN. This method
wasn’t foolproof because drives
with bad sectors could fully DBAN.
Sometimes our volunteers would

forget to hook up the data or
power cable, so the drive wouldn’t
be detected and would also fail
DBAN. The last method was to
examine the hard drive using
Gsmartcontrol. Gsmartcontrol is
great because it can instantly
detect certain kinds of SMART
(Self-Monitoring, Analysis and
Reporting Technology) errors.
Unfortunately, SMART isn’t
perfect. Wikipedia has an excellent
article covering SMART that
mentions that in one study more
than 50% of drives that failed did
so without triggering one of the
main SMART failure indicators.
To augment our SMART testing,
we’re starting to use WHDD, a tool
ported to Ubuntu by Eugene San.
WHDD bills itself as a hard disk
drive diagnostic and recovery tool.
What we like about WHDD is that
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it can run a disk read surface scan
fairly rapidly. Smartmontools and
Gsmartcontrol can be used to run a
short (approximately 2 minute)
electrical and mechanical test, but
the short test covers only a small
part of the drive. Both tools can
also be used to run a
Long/Extended test which scans
the entire surface of the drive, but
the Long test is as the name
describes, long. Even small (80GB)
hard drives can take several hours
to scan.
This is where WHDD comes in
handy. WHDD can run a complete
surface READ scan on an 80GB
hard drive in under 22 minutes (1 7
minutes on one of our Seagate
drives). Our larger 3TB drive (which
was completely full of data)
finished in 245 minutes. Below is a
small sampling of the time/size

contents ^

LINUX LAB

higher the speed. This makes a lot
of sense since newer drives should
have faster technology to read the
surface of larger sized drives. We
The ETA is an approximate
tested 1 5 drives of different sizes
Estimated Time of Arrival (finish)
WHDD displays at the beginning of and makes, and found (with the
odd exception) the trend of faster
the test. For the most part, the
ETA, unlike many time indicators, is speed seems to correlate with size.
Drive content didn’t seem to affect
fairly accurate – to within a few
the numbers as much as the
minutes. But, like other time
number of slowly read sectors.
indicators, it does suffer time
creep when the test comes across
During the read test, WHDD
several slowly read sectors. We
charts the number of blocks read
tested several drives and found
the average time for an 80GB hard at each of the following speeds: <3
ms, <1 0 ms, <50 ms, <1 50 ms, <500
drive to be about 22 minutes.
ms, > 500 ms. If you see a lot of
blocks in the <500 ms range and >
The Speed of the drive is a
fluctuating number. In general, we 500 ms range it’s a really good idea
to back up your data and switch to
found the larger the drive the
ratio we found for different drives
we measured.

a drive with better read times.
Below is a small sample of read
times for the same drives.
In the example, the Western
Digital WD5000AAKS-65V0 500GB
hard drive has 3 blocks in the
above 500 millisecond and 22
blocks in the between 1 50 to 500
millisecond range. If you’re
concerned about your drive being
fast, or worried about bad blocks,
this might be a good indication
that it’s time to back up and
replace the drive.
But what about data? Does the
amount of data affect the time
data is read by WHDD? In these
charts, all the drives were blank

with the exception of the 3TB
Seagate ST3000DM001 -1 ER1 66
which was almost full of very large
files (20GB+ files). Although it took
the longest to read, it’s also 6
times the size of the 500GB drive.
If we take the 90 minutes of the
500GB drive, and multiply it by 6,
we get 540 minutes, almost double
the time the 3TB actually took to
read. From this we can conclude
that WHDD doesn’t seem to be
affected much by the amount of
data on a computer (it also helps
that newer drives are simply
faster).
WHDD is a command line tool
and needs sudo permission to run:
sudo whdd

WHDD can show SMART
attributes, run a read test, run a
copy test, run a write test, or set
up a host protected area (HPA), a
hidden area of the drive an OS
can’t normally read. WHDD doesn’t
do the kind of SMART short test
that Smartmontools or
Gsmartcontrol does, but one of the
neat things that WHDD might tell
you (when looking at the SMART
attributes) is if the hard drive has a
firmware update available.
full circle magazine #1 08
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Read, Copy and Write tests are
all visual. As each block is
read/copied/written, it’s displayed
much as you’d expect a block
read/copy/write test to display, as
a block. Quickly read blocks are
mostly black with a tiny bit of grey,
blocks up to 50ms access time are
still grey. Blocks under 1 50ms
access time are green. Blocks over
1 50ms are displayed in red and
blocks over 500ms are displayed in
bright Salmon color. Errors are
indicated by what looks to be a

been suddenly shut down, but it
doesn’t always help when a drive is
simply slower than you might
expect. This is where WHDD can be
a great tool.

small bug.
At any time during a test, you
can stop the test by pressing
CTRL+C. To get back to the WHDD
menu, press m (after aborting the
test with CRTL+C).
WHDD is a great tool when
SMART doesn’t tell the whole
story. SMART can tell you a lot
about a hard drive: it can tell you
the number of hours in use,
whether a sector has been
reallocated, even if the system has

In summary: if you’re just
checking out blank drives, listen
first – if a drive sounds bad, but
tests good with a SMART tool like
Gsmartcontrol or Smartmontools,
give it another quick read test with
Of course there is no substitute WHDD. If you’re worried about
for a good backup. More than any data on a drive, back it up first with
other tool, a good backup can save rsync (or dd if you have an identical
you the most grief. Whether you’re or larger drive to copy to), then
a system administrator or just
check with one of the SMART tools
storing terabytes of music and
and WHDD to get a better
video on your home media server, overview of what’s going on with
you want some kind of backup to
your drive(s).
ensure your data (and effort)
doesn’t disappear if a drive fails.
GSmartcontrol:
http://gsmartcontrol.sourceforge.
Alan Ward wrote an excellent
net/home/
article on backup using rsync in
FCM#83 :
Smartmontools:
http://fullcirclemagazine.org/issue https://www.smartmontools.org/
-83
WHDD: http://whdd.org/

Charles is the author of Instant

XBMC, and the project manager of a
not-for-profit computer reuse
project. When not building PCs,
removing malware, and encouraging
people to use GNU/Linux, Charles
works on reinventing his blog at
http://www.charlesmccolm.com/.
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Written by Ronnie Tucker

OTA-1 0

W

below.

e have a summary list of
updates made for OTA-1 0

The following apps are now preinstalled by default:
• Email app (Dekko)
• Calendar app
• uNav
General enhancements:
• New theme and color palette
• Updated OOBE (Out Of Box
Experience – provides a better
initial setup experience for new
users)
• Updated Edge tutorial
• VPN support added to Settings
• New system indicator with
desktop mode toggle for
convergence
• Updates can now be downloaded
over 3G
• Control added for external mic
volume

NOTE: There has since been a

quick update to this with the
release of OTA-1 0.1 to fix a small
security issue which was
discovered after the release of
OTA-1 0.

BQ M1 0 TABLETS N OW
SHIPPING

B

Q have been sending out
emails letting buyers know
that the M1 0 tablet has begun
shipping. Some people have
already received their tablets, and
a couple of reviews have sprung up
online.

A complete list of changes can
be found at:
https://wiki.ubuntu.com/Touch/Rel
easeNotes/OTA-1 0
full circle magazine #1 08
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Written by Art Schreckengost

ooking for a light Ubuntubased distro that won’t break
your hard drive?

so let’s put it to the test (yes, I
know the punctuation is lacking,
but it is on the website, too).

that much horsepower and RAM
for smooth operation).

How many times have your
heard that pitch and then
discovered that light usually means
stripped or sorely lacking in
necessary components and
codecs?

As for the simple aspect, LL
(what I’ll call Linux Lite from here
on) is not only small in size but will
be quite happy with minimal-spec
systems. With a base requirement
of just 700MHz and 51 2MB RAM,
this should work on just about any
PC made after 2000 (truthfully,
they do recommend at least twice

Those opting for a full or VM
install will be happy to see the
usual Ubiquity installer. A few
Of course, it’s obviously free,
clicks and keystrokes, and you’ll be
but is it fast?
ready for setup which takes
roughly 20 minutes (faster if you
Well, that depends. If you plan
use a USB/flash drive instead of a
on using the Live version off a DVD DVD).
or USB/flash drive, it won’t be any
Cold boots are nothing
spectacular at around 20 seconds
on my decade-old Dell, but I did
find it odd, that’s with a GRUB
boot delay of 0. Hmmm, that may
take some work.

Enter Linux Lite 2.8 from New
Zealand. Based on Ubuntu 1 4.04
LTS (Trusty Tahr), it carries a
feather logo that may seem
somewhat familiar to Linux
oldsters like myself -- it’s the same
one carried by the now deceased
U.K. based Feather Linux (R.I.P.
2006).

Guess my decade-old Dell Core
Duo pushing 3GB RAM should fit
the bill.

quicker than any other similar
offering but that has always been a
drawback to Live systems.

And that’s where the similarity
ends. Feather was Knoppix/Debian
based, carried a Fluxbox desktop,
and was a super lightweight at shy
of 1 25MB. In comparison, Linux
Lite packs a much heftier 800MB
package.

In keeping with the minimalistic
theme, the desktop consists of a
bottom taskbar with the usual
system parameter icons, and a
menu button along with the
feather logo on a grayish
background. Nicely presented
while still being functional.

The website
(https://www.linuxliteos.com)
claims its OS is “Simple Fast Free”,

Ah, but here is where things get
interesting. After every boot, at
least until you tell it otherwise,
full circle magazine #1 08
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you’ll get the “Welcome to Linux
Lite” pop-up screen, a rather
ingenious way of handling basic
system needs.

mentioned above.

ugly in the process.

As for software installation, you
For such a lightweight package,
also find another neat program
LL does come with quite a few
minimally titled “Lite Software”.
standard programs such as:
Unlike Mint’s welcome screen,
• Firefox (with options to install
this one actually contains
Although the box itself seems
Chrome and Chromium).
information I found useful after
simplistic and somewhat crude by • LibreOffice 5 (I mention the
the first few boots (sorry, Mint,
design, it’s effective for its
number since other distros I’ve
but it did become repetitive until I intended purpose -- installing
tried have older versions) with
pulled the plug).
roughly 1 5 to 20 of the most often Evince as the PDF add-on.
used or requested programs.
• Thunderbird for email.
Inside this box you’ll find
• GIMP and Image Viewer.
headings for updating and
For other programs, there’s the • xfburn for CD/DVD production,
upgrading both the system and
Synaptic Package Manager which, Clementine and VLC for media
software, plus there’s another
in this case, is renamed
playback.
section for the installation of
“Install/Remove Software” (but
• The standard pot of accessories
“Lite” software to include Chrome, when it comes up, the header
such as calculators and screenshot
Chromium, Tor, Dropbox, Kodi,
clearly states Synaptic).
packages.
Skype, Teamviewer and Virtualbox.
• Lite Tweaks, a program that
The desktop is utilitarian Xfce
cleans the garbage out of your
This makes updating and
all the way. If you’re looking for
system without having to rely on
upgrading a simple one-click affair visual pizazz and gizmos galore,
somewhat questionable outside
instead of waiting for the system
you might prefer another distro.
programs that may do more
to dump a 500MB surprise in your It’s functional while not looking
damage than good. If you’re
lap at some future date.
As for the Lite software
programs, this must be partially
built in to the system because
installation was a whole lot easier
than downloading them
individually via Synaptic. I’d be
exaggerating if it took any more
than 5 minutes to download and
install all of those programs
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wondering, no, it’s not related to
Ubuntu Tweak.
• Systemback, a unique one or twoclick backup that can create a live
version of your setup without
having to install anything else.
Not a bad selection for what
should be a light, limited distro.
Even more impressive is that
after adding a load of personal
program choices plus the built-in
offerings, my HDD is down just
7.1 GB.
Once you get everything loaded
to your liking, the system is not
only highly functional and stable,
it’s quick to perform also. In fact,
the only time I experienced a
slowdown was when I used
Systemback for a complete ISO
image (that did hijack my system
for roughly 1 5 minutes), but I
expected that.
That isn’t to state that’s in all
hunky-dory here, folks. There was
an odd failure to communicate
when I went to use the Lite
Software package after a couple
days of system usage. It developed
a tick in the software sources list
and gave me an update error
based upon the “trusty/main”
contents ^

REVIEW - LINUX LITE

archives. As such, Lite Software
hasn’t worked since.

THE O FFICIAL FULL CIRCLE APP FOR U BUNTU TOUCH

B

That’s definitely going to need
a workaround although most users
will probably click over to other
sources such as the Install/Remove
Software mentioned before.

rian Douglass has created a

fantastic app for Ubuntu Touch
devices that will allow you to view
current issues, and back issues, and
to download and view them on your
Ubuntu Touch phone/tablet.

So, what’s the final consensus
on Linux Lite? Personally, I found it
to be just as functional as other
lightweights in the Ubuntu family,
including Lubuntu and Xubuntu.
However, LL has more included
programs and is more aesthetically
pleasing (it may be a nearbarebones OS but it doesn’t look
like such).

I NSTALL
Either search for 'full circle' in the
Ubuntu Touch store and click
install, or view the URL below on
your device and click install to be
taken to the store page.
https://uappexplorer.com/app/
fullcircle.bhdouglass

True, it has a couple quirks and
may need a little tweaking, but I’ve
experienced a whole lot worse in
my day.
In the end analysis, it has a
small footprint, some great
tweaks, and operates better than
most in the class.
Give it a try and I’m sure you’ll
agree.
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LE T TE RS

If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
full circle magazine #1 08

47

contents ^

Q &A

If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

Compiled by Gord Campbell

I installed Viber from the
Q Viber
web site, but it doesn't
run.

A

(Thanks to howefield in the
Ubuntu Forums) Try installing
libgstreamer-plugins-base0.1 0-0
It looks like the package
creators have missed referencing a
dependency (or the dependencies
have changed) from their package.

Q

Is there Linux software which
will read and work with
PowerPoint files?

A

(Thanks to linuxkvh in the
Ubuntu Forums) Try
LibreOffice Impress. Minor
compatibility issues might happen
when loading PowerPoint
presentations, so it's best to use
only LibreOffice when working on
a new presentation.

good with PowerPoint files.

during boot if you don't see it).

of RAM and only
Q 2GBI haveare4GBavailable.

And the previous kernel solved
the problem.

a way to notify users
Q ofIs there
password expiration at
logon?

A

Q

A

I'm using Ubuntu 1 4.04 on my
Q Asus
X205T. Yesterday the

A

TOP QUESTIONS AT
ASKUBUNTU

After swapping RAM sticks
around, it became apparent
that two of the four slots were not
working. The Original Poster also
noticed "a bulged up capacitor", so
it's a hardware problem.

updater installed some stuff and
asked to restart; I said ‘later’. The
next time I started up, the
touchpad doesn't work at all.

A

(Thanks to sudodus in the
Ubuntu Forums) Some
computers have a button to turn
the touchpad on and off. Maybe
you can check if you can turn it on
with a hotkey combination, maybe
the 'Fn' key + an 'F' key. My laptop
A second option is to use MS
has the Fn + F5 key combination
Office under Wine.
for this purpose. One alternative is
to boot a previous kernel via the
marseille2 suggests WPS
Office, which he says is particularly grub menu (press the shift key
full circle magazine #1 08

I installed my new computer
with Ubuntu 1 2.04.4. When I
start up the computer, I get one
notification of "Network
Disconnected - you are now
offline". The Ethernet port does
not appear in ifconfig output.
New computer, old OS, bad
outcome. Try 1 5.1 0. (Which
worked.)

I am using gadmin-samba to
Q configure
shared folders, but
it's not working.

A

(Thanks to bab1 in the
Ubuntu Forums) I can't stress
this too strongly -- DO NOT USE

Gadmin-samba TO CONFIGURE A
SAMBA FILE SERVER . Purge

everything to do with gadminsamba, and start over. Setting up a
simple file server is not very
difficult.
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This does not answer your
question, but it should be
relevant: most security experts
now feel that having passwords
expire is a bad thing, which
actually reduces security.

* Unable to find the .lit file reader
conversion app clit
http://goo.gl/9dTGfd
* Moving entire Linux installation
to another drive
http://goo.gl/k7BrZC
* Does rolling back the kernel in
Ubuntu compromise security
http://goo.gl/BNZdKF
* How to stop the pointer jumping
around due to the touchpad?
http://goo.gl/7Mo4N3
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Q&A
* Which package is the command
'cd' in?
http://goo.gl/zfrmXi
* How do I run a sudo command
needing password input in the
background?
http://goo.gl/a3OPnq
* I have a file named "-t". How to
remove it?
http://goo.gl/vfjoL7
* Why won't this script run on
startup?
http://goo.gl/mn3ezn
* How to add accents, etc, to
letters using the "English (UK)"
input source?
http://goo.gl/sLCmkM

TIPS AND TECHNIQUES
Information, Please

A

ctivity in the Ubuntu Forums
has dropped by half over the
past few years, which is probably a
good thing, since it means that
fewer people need help.
However, I have noticed that a
lot of the people who ask for help

provide about 1 0 per cent of the
information that anyone would
need to help them. At the risk of
repeating myself, I would like to
make some suggestions.
It's almost always relevant to
tell people what version of Linux
you are using. For example,
"Xubuntu 1 5.1 0 64-bit". There's no
single way to get this information
which works across various
versions of Linux, so you should
write it down when you download
it – if there is any chance you will
forget.
It is often relevant to tell
people about your computer. In
order of relevance: memory, video
adapter, CPU, and hard disk size
and layout. And sometimes, the
Wi-Fi adapter or audio device. My
favorite program for getting this
information is lshw, which can
provide nicely formatted details
about your system:

If you have a question that
involves a website, identify it. "I
have a problem playing video
1 5601 5647 on vimeo.com" is a lot
more useful than "I have a problem
playing online videos".
If you get an error message, the
exact message is obviously
relevant. If you can't record it any
other way, take a picture with your
cellphone.
Then there's one more step: put
the organized data into Google! My
best Google queries have used
four words, but you need to think
about what four words are most
relevant. My personal experience is
that I almost always find the
answer, so I don't need to ask a
question.

cd Desktop
sudo lshw -html >
myconfig.htm

Identify the application, if you
have a question about it. It's not
"my backup program," it's "rsync".
(Or whatever.)
full circle magazine #1 08

Gord had a long career in the

computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.
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U B U N T U G AM E S

H

G o Pa n d a

Written by Ronnie Tucker

aving watched the AlphaGo
and Lee Sedol matches via
YouTube, I decided to buy a couple
of books and give Go a try.
I managed to easily find a
couple of Go apps for Android, but
had difficulty finding a good piece
of Go software for Linux.
Eventually I came across GoPanda.
GoPanda is basically a front-end
for IGS PandaNet (aka: Panda
Network) that allows players to
watch, play and discuss Go. The
software can also let you review
Go games using the SGF file
format. While having Java-based
software may make some people
groan, at least it allows Linux users
to get involved in playing Go.

REGISTERING
Head to the PandaNet site at:
http://pandanet-igs.com/. In the
right-hand-side column, there’s a
button saying ‘Register’. Click that.
Or you can click the big ‘Play on
Pandanet!’ button to get a popup
with a registration button.

Fill in the details such as
username, password, email, etc.
Finally, click ‘Register’, and wait
for a confirmation email. Since the
confirmation email can sometimes
take a little while, let’s get
installing.

I NSTALLING
First thing to do is grab the
archive file from: http://pandanetigs.com/communities/gopanda2/1
00/
For using the software there’s
also a PDF manual at:
http://www.pandanet.co.jp/top_ne
wsph-igs/GoPandasmanual.pdf

PLAYING
Top right, in the GoPanda
window, is the login button. You’ll
need to log in to connect to
PandaNet:
You’ll now be in the main room

(shown above) with a list of
currently playing matches. You can
click on one of these matches, and,
from the popup menu, choose
‘Observe’ (shown below).
You are now watching the
match... live.

Unarchive the .tar.gz file to
somewhere, and open that newly
created GoPanda2 folder. In there,
you’ll see an icon called GoPanda2.
That’s the executable to run
GoPanda. Double-click it and you’re
off and running!
On the first run, the software
will update itself.
full circle magazine #1 08
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click OK.
Don’t be surprised if it says the
player is already in a game. This

Everything in GoPanda opens
like browser tabs, so clicking the X
in the game tab (below the
GoPanda logo) lets you leave the
game.
So, now you’re back to the main
room. Now what? Well, if you’re
like me and don’t want to just dive
in and get soundly thrashed by a
pro, you click the drop-down menu
(in the main room) and choose
‘Beginners (Robots)’ (shown top
right). This opens a new tab with

happens when someone jumped in
before you to challenge that robot.
Try another robot. TIP: check the
games in progress on the left to

people playing robots.
But, on the right hand side
(where it lists players), you’ll see
players named Robot. They’re
available for games. Most are 1 2k+,
which means they’re more than
enough for a total noob like me.
Click a robot name, choose
‘Challenge’, and you’ll get a popup
with some game settings. Things
such as rules, board size,
handicap/not, time, etc. Finally,
full circle magazine #1 08
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see which robots are currently in
use.
So now you know how to
observe and play on PandaNet. But
there’s more! You can click on a
player's name to view their stats,
send messages, add as a friend,
and (best of all) you can click
‘Game archive’ and see a list of
their past games. From that list

you can then observe (or
download) the game to watch it
step-by-step.

G O O N THE G O
For Go, on the go, there’s also
Android and iOS apps for GoPanda.
Android app:
https://play.google.com/store/app
s/details?id=be.gentgo.tetsuki&hl=
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en_GB (sorry, I’ve no iOS device for
an app link).

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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PATRONS
Bill Berninghausen
Jack McMahon
Linda P
Remke Schuurmans
Norman Phillips
Tom Rausner
Charles Battersby
Tom Bell
Oscar Rivera
Alex Crabtree
Ray Spain
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Charles Anderson
Ricardo Coalla
Chris Giltnane
William von Hagen
Mark Shuttleworth
Juan Ortiz
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Doug Bruce
Pekka Niemi
Rob Fitzgerald
Brian M Murray
Roy Milner
Brian Bogdan
Scott Mack
Dennis Mack
John Helmers
JT

Elizabeth K. Joseph
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John Niendorf
Daniel Witzel
Douglas Brown
Donald Altman
Patrick Scango
Tony Wood
Paul Miller
Colin McCubbin
Randy Brinson
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Chris Burmajster
Steven McKee
Manuel Rey Garcia
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PONG Wai Hing
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Marcos Alvarez Costales
Raymond Mccarthy
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Max Catterwell
Frank Dinger
Paul Weed

CHA CHA CHA CHANGES
Our admin went AWOL for months, and
I had no idea if/when the site
would/wouldn’t get paid. Initially the
plan was to move the site and domain
name to my hosting, but eventually I
managed to track him down and get
the FCM domain name, and site hosting
transferred to me.
The new site is now up. HUGE thanks to
Lucas Westermann (Mr. Command &
Conquer) for taking on the job of
completely rebuilding the site, and
scripts, from scratch, in his own time.
The Patreon page that I’ve set up is to
help me pay the domain and hosting
fees. The yearly target was quickly
reached thanks to those listed on this
page. FCM is not going away. Don’t
worry about that.
Several people have asked for a PayPal
(single donation) option, so I’ve added
a button to the side of the site

A big thank you to all those who’ve
used Patreon and the PayPal button.
It’s a big help.

https://www.patreon.com/
fullcirclemagazine
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H OW TO CO N TRI BU TE

Full Circle Team
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FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

Deadline :

Sunday 08th May 201 6.
Release :
Friday 27th May 201 6.

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide : http://url.fullcirclemagazine.org/75d471
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

For the Full Circle Weekly News:

Webmaster - Lucas Westermann
admin@fullcirclemagazine.org
Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:

EPUB Format - Most editions have a link to the epub file

on that issues download page. If you have any problems
with the epub file, email: mobile@fullcirclemagazine.org

You can keep up to date with the Weekly News using the
RSS feed: http://fullcirclemagazine.org/feed/podcast

Issuu - You can read Full Circle online via Issuu:

Or, if your out and about, you can get the Weekly News
via Stitcher Radio (Android/iOS/web):
http://www.stitcher.com/s?fid=85347&refid=stpr
and via TuneIn at: http://tunein.com/radio/Full-CircleWeekly-News-p855064/
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Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org

http://issuu.com/fullcirclemagazine. Please share and rate
FCM as it helps to spread the word about FCM and Ubuntu.

Magzster - You can also read Full Circle online via

Magzster: http://www.magzter.com/publishers/Full-Circle.
Please share and rate FCM as it helps to spread the word
about FCM and Ubuntu Linux.
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